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Welcome
The TekExpress Automotive Ethernet (100/1000Base-T1) is a compliance test
solution for performing Transmitter electrical specification tests and MDI
electrical specification Return Loss test of the transmitter as per OPEN Alliance
BroadR-Reach (OABR) specification version 3.2. and IEEE P802.3bwTM

D3.3 for 100 Base-T1 and IEEE P802.3bpTM for 1000Base-T1. These
specifications have a stated objective to provide electrical interoperability for
100/1000 Mbps client and the same electrical test requirements to the Physical
Medium Attachment (PMA) transmitter electrical specifications.

The Automotive Ethernet (100/1000Base-T1) is an Ethernet-based point-to-point
technology for automotive applications.
 

 

Key features
■ Fully automated application with setup wizard, to perform compliance testing

as per the Automotive Ethernet 1000Base-T1TM (802.3bp) and IEEE
P802.3bwTM (100Base-T1) standards.

■ Compliance testing to perform signal qualification
■ Automated report generation with Pass/Fail results along with screenshot of

the waveform(s).
■ The 100/1000Base-T1 specification defines Return Loss measurement that

requires a Vector Network Analyzer (VNA). TekExpress Automotive
Ethernet application offers you a patented Return Loss measurement, which
allows you to perform the measurement without using a VNA.

■ Transmitter Timing Jitter-MDI Jitter measurement for 1000Base-T1
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■ Transmit distortion measurement without need of external hardware clock
divider unit, using software signal correction method.

■ Run the measurement(s) for the user specified number of iterations.

Welcome  

vi  TekExpress Automotive Ethernet



Getting help and support

Conventions
Help uses the following conventions:

■ The term "Application" and "Software" refers to the TekExpress Automotive
Ethernet Solution application.

■ The term “DUT” is an abbreviation for Device Under Test.

■ The term “select” is a generic term that applies to the different methods of
choosing a screen item (button, control, list item): using a mouse or using the
touch screen.

Table 1: Icon descriptions

Icon Meaning
This icon identifies important information.

This icon identifies conditions or practices that could result in loss
of data.

This icon identifies additional information that will help you use
the application more efficiently.
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Related documentation
The following documentation is available as part of the TekExpress® Automotive
Ethernet Solution application.

Table 2: Product documentation

Item Purpose Location
Help Application operation

and User Interface help

PDF of the help Printable version of the
compiled help

PDF file that ships with Automotive Ethernet
Solution software distribution (TekExpress
Automotive-Ethernet-Automated-Test-Solution-
Software-Printable-Help-EN-US.pdf).
You can download the PDF version of the
manual from the Tektronix website.
www.tek.com

Automotive Ethernet Return Loss Measurement-
VNA.pdf (MOI)

The PDF file contains method of implementation
for return loss measurement using a vector
network analyzer.
You can access this file at C:\Program Files
\Tektronix\TekExpress\TekExpress Automotive-
Ethernet\

See also: Technical support
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Technical support
Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the website.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General information ■ All instrument model numbers
■ Hardware options, if any
■ Probes used
■ Your name, company, mailing address, phone number, FAX number
■ Please indicate if you would like to be contacted by Tektronix about your

suggestion or comments.

Application specific
information

■ Software version number
■ Description of the problem such that technical support can duplicate the

problem
■ If possible, save the setup files for all the instruments used and the

application
■ If possible, save the TekExpress setup files, log.xml, *.TekX (session files

and folders), and status messages text file
■ If possible, save the waveform on which you are performing the

measurement as a .wfm file

 Getting help and support
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Getting started

Minimum system requirements
The following table shows the minimum system requirements to install and run
the TekExpress Automotive Ethernet application.

Component Description
Oscilloscope Supported Oscilloscopes

■ DPO5104, DPO5204
■ DPO5104B, DPO5204B, MSO5104B, MSO5204B
■ DPO7104C, DPO7254C, DPO7354C
■ DPO70404C, DPO70604C, DPO70804C, DPO71254C,

DPO71604C, DPO72004C
■ DPO/DSA 70KD series
■ DPO72504DX, DPO73304DX, DPO72304DX,

DPO72504DX, DPO73304DX
■ DPO71304SX, DPO71604SX, DPO72304SX,

DPO73304SX

Signal Generators AFG3022C, AFG3052C,
AFG3102, AFG3252/C,
AFG31102, AFG31152,
AFG31252

100Base-T1

AWG5002B/C, AWG5012B/C,
AWG5014, AWG50B,
AWG5202, AWG5204,
AWG7082/B/C, AWG7102
(Option 2), AWG7122B/C
AFG3152C, AFG3252C,
AFG3252, AFG31152,
AFG31252

1000Base-T1

AWG5202, AWG5204,
AWG5208

Processor Same as the oscilloscope
Operating System Windows 10 and Windows 7 
Memory Same as the oscilloscope
Hard Disk Same as the oscilloscope
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Component Description
Display Super VGA resolution or higher video adapter (800 x

600 minimum video resolution for small fonts or 1024 x
768 minimum video resolution for large fonts). The application is
best viewed at 96 dpi display settings

NOTE. If TekExpress is running on an instrument that has a
video resolution less than 800x600, connect and configure a
second monitor to the instrument.

Firmware ■ TekScope 10.10.1 and above

Software ■ IronPython 2.7.3 installed

■ PyVisa 1.0.0.25 installed

■ Microsoft .NET 4.0 Framework

■ Microsoft Internet Explorer 7.0 SP1 or greater, or other Web
browser for viewing reports

■ Adobe Reader software 7.0 or greater for viewing portable
document format (PDF) files

Other Devices ■ Microsoft compatible mouse or compatible pointing device.

■ Two USB ports (four USB ports recommended).

NOTE.
■ Use AWG automation for Return Loss and Transmitter Distortion with

Disturbing Signal measurements.
■ Return Loss measurement is supported only on AWG5202, AWG5204, and

AWG5208 with High Power option (AWG5200-2HV/AWG5200-4HV: High
Amplitude DC coupled outputs) for AWG5200 S/N B020000 and above.

■ For 1000Base-T1, use the Signal Generator, which can generate the
1.8 Volts Peak-to-peak.

See also

Instruments and accessories required
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Instruments and accessories required

Table 3: Instruments and accessories required

Instrument/
Accessories

Model / Accessories

Probes 100Base-T1 TDP1500, P6248, P6247 and TDP3500
differential probes.
TDP7700 (TDP7704/6/8) Series TriMode™ with
P77STCABL and P77C292MM  1 adapter for
MSO6 series oscilloscopes.

1000Base-T1 TDP3500 ±15 V DC + pk AC input voltage
differential probe.
TDP7700 (TDP7704/6/8) Series TriMode™ with
P77STCABL and P77C292MM1 adapter for
MSO6 series oscilloscopes.

Test fixtures: TF-XGbT Not applicable

Frequency divider 100Base-T1
The TF-BRR-CFD test fixture allows to phase lock frequency between
DUT Transmitter Clock, oscilloscope, and AWG/AFG sources.
Converts DUT Transmitter Clock from 66.666 MHz to 10 MHz.
1000Base-T1
The TF-BRR-CFD fixtures allows to phase lock frequency between DUT
Transmitter Clock, oscilloscope, and AWG/AFG sources.
Converts DUT Transmitter Clock from 125 MHz to 10 MHz.

Cables 100Base-T1
Six same length BNC cables/SMA cables with BNC to SMA connectors:
one TCA-BNC or TCA-SMA
1000Base-T1
Six same length BNC cables/SMA cables with BNC to SMA connectors:
one TCA-BNC or TCA-SMA

Instrument/Accessories Model / Accessories
Other devices Adaptor TCA-VPI50 and TDP3500 for DPO/

DSA/MSO 70K Series Oscilloscopes  2

1 P77C292MM supports all tests except Transmitter Distortion and Return Loss.
2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for communicating with oscilloscope

applications. If external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, ensure that the Talker
Listener utility is enabled in the DPO/DSA Oscilloscope's GPIB menu. For ease of use, connect to an external (secondary) monitor.

 Getting started
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See also Minimum system requirements

Install the software
Complete the following steps to download and install the latest TekExpress
Automotive Ethernet application. See Minimum system requirements for
compatibility.

1. Close all applications (including the TekScope application).

2. Go to the www.tek.com.

3. Click Downloads. In the Download menu, select DOWNLOAD TYPE as
Software and enter TekExpress Automotive Ethernet in the MODEL OR
KEYWORD field and click SEARCH

4. Select the latest version of software and follow the instructions to download.
Copy the executable file to the oscilloscope

5. Double-click the executable and follow the on-screen instructions. The
software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress
Automotive-Ethernet\

6. Select Application>TekExpress Automotive Ethernet from the TekScope
menu to launch the application.

See also

Minimum System Requirements

Activate the license
Activate the license using the Option Installation wizard in the TekScope
application:

1. In the TekScope application menu bar, click Utilities > Option Installation.

The TekScope Option Installation wizard opens.

2. Push the F1 key on the oscilloscope keyboard to open the Option Installation
help topic.

3. Follow the directions in the help topic to activate the license.

See also

View Version and License Information
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View version and license information
Use the following instructions to view application version information and
license information for the application modules such as the Programmatic
Interface and the Programmatic Interface Client.

To view version information, click in the TekExpress application and select
About TekExpress.

See also Activate the license

Options menu

Application directories and usage
The TekExpress Automotive Ethernet application files are installed at the
following location:

C:\Program Files\Tektronix\TekExpress\TekExpress Automotive-Ethernet\.
 

 

 Getting started
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The following table lists the default directory names and their usage.

Table 4: Application directories and usage

Directory names Application specific information
AWG Waveforms It contains AWG waveforms (AWG 5K, 7K and

AFG waveforms) that get used in return loss and
distortion with disturbing signal .

Bin It contains miscellaneous TekExpress
Automotive-Ethernet libraries.

Compliance Suites It contains compliance-specific files and filter
files.

Examples It contains various support files.
Filters Filters that are applicable for 100 and

1000Base-T1 Jitter and Power Spectral Density
measurements.

ICP It contains instrument and TekExpress
Automotive-Ethernet-specific interface libraries.

Images It contains images required for the application.
Lib It contains utility files specific to the TekExpress

Automotive-Ethernet.
Report Generator It contains style sheets for report generation.
Tools It contains instrument and TekExpress

Automotive-Ethernet-specific files.

See also

View test-related files
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File name extensions
The TekExpress Automotive Ethernet software uses the following file name
extensions:

Table 5: File name extensions

File name extension Description
.TekX Session files are saved in this format but the

extensions may not be displayed
.py The test sequence file
.xml The encrypted XML file that contains the test-

specific configuration information
The log file extension is also xml

.wfm The test waveform file

.mht

.pdf

.csv

Test result reports are saved in MHTML format
by default. Test reports can also be saved in
CSV and PDF format.
Test result reports are saved in MHTML format
by default. Test reports can also be saved in
MHTML format and .pdf.

.cal Calibration file used with transmitter tests

See also Application directories and usage

 Getting started
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Operating basics

Start the application
To launch the TekExpress Automotive Ethernet application, select Analyze >
TekExpress Automotive Ethernet from the TekScope menu.

The oscilloscope opens the TekExpress Automotive Ethernet application:
 

 

When you run the application for the first time after installation, the application
checks for Resources.xml located in the C:\Users\<username>\Documents\My
TekExpress\TekExpress Automotive-Ethernet\ folder. The Resources.xml file
gets mapped to the X: drive when the application launches. Session files are then
stored inside the X:\TekExpress Automotive-Ethernet\ folder. The Resources.xml
file contains information about available network-connected instruments. If the
application does not find the file, it runs an instrument discovery program to
detect connected instruments before launching TekExpress Automotive Ethernet.

To keep the TekExpress Automotive Ethernet application window on top, select
Keep On Top from the Options menu. If the application goes behind the
oscilloscope application, click Analyze > TekExpress Automotive Ethernet to
bring the application to the front.
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See also Application controls

Application basics
TekExpress Automotive Ethernet uses panels to group related configuration, test,
and results settings. You can open any panel by clicking on it. A panel may have
one or more tabs that lists all the options applicable. Options in a panel can
change depending on the settings made in that panel or another panel.
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Table 6: Application panels overview

Panel Name Purpose
Setup The Setup panel shows the test setup controls. Click the Setup button to

open this panel.
Use this panel to:

■ Set DUT tab parameters.

■ Selecting tests.

■ Selecting acquisition tab parameters for selected tests.

■ Set preferences tab.

Status View the progress and analysis status of the selected tests, and view test
logs.

Results View a summary of test results and select result viewing preferences.
Reports Browse for reports, save reports as specific file types, specify report

naming conventions, select report content to include (such as summary
information, detailed information, user comments, setup configuration,
application configuration) and select report viewing options.

Plots View a summary of plot generated during run.

See also Application controls

Global application controls

Application controls

 Operating basics

TekExpress Automotive Ethernet 15



Table 7: Application controls descriptions

Item Description
Options menu
 

 

Menu to display global application controls.

Test Panel buttons
 

 

Controls that open panels for configuring test settings and options.

Start / Stop button
 

 
 

 

Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements have not been cleared, the new measurements are added to the
existing set.
The button toggles to the Stop mode while tests are running. Use the Stop button to abort
the test.

Pause / Continue button
 

 
 

 

Use the Pause button to temporarily interrupt the current acquisition. When a test is
paused, the button name changes to “Continue.”

Operating basics  
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Item Description
Clear button
 

 

Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or sets
of statistics that are not coherent. This button is available only on the Results panel.

Application window move icon
 

 

Place the cursor over the three-dot pattern in the upper left corner of the application
window. When the cursor changes to a hand, drag the window to the desired location.

Minimize button
 

 

Minimizes the application.

Close button
 

 

Closes the application.

Mini view / Normal view
 

 
 

 

Toggles the application between mini view and normal view.
Mini view displays the run messages with the time stamp, progress bar, Start / Stop button,
and Pause / Continue button.
The application automatically moves to the mini view when you click the Start button.
 

 

See also

Options menu

 Operating basics
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Options menu Options menu. The Options menu is located in the upper right corner of the
application.

It has the following selections:

Table 8: Options menu

Menu Function
Default Test Setup Opens an untitled test setup with defaults selected.
Open Test Setup Opens a saved test setup.
Save Test Setup Saves the current test setup selections.
Save Test Setup As Creates a new test setup based on an existing one.
Open Recent It displays a menu of recently opened test setups to select from.
Instrument Control Settings It shows the list of instruments connected to the test setup and

allows you to locate and refresh connections to connected
instruments.

Keep On Top It keeps the TekExpress Automotive Ethernet application on top
of other open windows on the desktop.

Email settings It configures email options for test run and results notifications.
Help It displays TekExpress Help.
About TekExpress ■ It displays application details such as software name,

version number, and copyright.

■ It provides access to license information for your
TekExpress Automotive Ethernet application installation.

■ It provides a link to the Tektronix Website.

Operating basics  
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Instrument configuration
using TekVISA

To configure the instrument using TekVISA, use the following steps.

1. Select oscilloscope window menu and click OpenChoice Instrument
Manager.
 

 

2. Click the Update button and wait to update the list. The AWG which is
connected to LAN displays the Instruments connected list. If the list is not
displayed follow the steps.

■ Click Search Criteria and select LAN.

■ Turn it ON, if the LAN is Off.

■
Enter the AWG IP address in Hostname field and Press  button.

■ Click Search button and wait for your AWG instrument to discover and
display the list.

■ Click Done.

 Operating basics
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■ Click Update. It refreshes the instruments discovered and displays the
list.
 

 

TekExpress instrument
control settings

Use the Instrument Control Settings dialog box to view or search for connected
instruments required for the tests. The application uses TekVISA to discover the
connected instruments.

Figure 1: Instrument Control Settings

Operating basics  
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To refresh the list of connected instruments:

1. From the Options menu, select Instrument Control Setting.

2. In the Search Criteria section of the Instrument Control Settings dialog box,
select the connection types of the instruments to search.

Instrument search is based on the VISA layer but different connected cables
determine the resource type, such as LAN, GPIB, USB. For example, if you
choose LAN, you can search for all the instruments supported by TekExpress
that are communicating over the LAN. If the search does not find any
instruments that match a selected resource type, a message appears telling
you that no such instruments were found. Click OK to close the message
window.

NOTE. Ensure that the GPIB option is enabled to detect the real time
oscilloscope in the Global Settings tab.

3. Click Refresh.

TekExpress searches for connected instruments.

4. After discovery, the dialog box lists the instrument-related details based on
the search criteria you selected. For example, if you have selected LAN and
GPIB as the search criteria, the application checks for the availability of
instruments over LAN, then GPIB.

The details of the instruments are displayed in the Retrieved Instruments
table. The time and date of instrument refresh is displayed in the Last
Updated field.

 Operating basics
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Configure email
notification

Set up these email settings if you want the application to notify you by email
when a test completes or produces an error. Configure email from the Options
menu.

1. From the Options menu in the upper right corner, select Email Settings to
open the Email Settings dialog box, or click the Preferences tab on the Setup
panel.

Figure 2: Email Settings dialog box

2. (Required) For Recipient email Address(es), enter your email address. You
can include multiple addresses as long as you separate the addresses with
commas.

3. (Required) For Sender's Address, enter the email address used by the
instrument. This address consists of the instrument name, followed by an
underscore, followed by the instrument serial number, the @ symbol, and the
email server used. For example: DPO72004C_B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

■ Reports: Select to receive the test report with the notification email.

Operating basics  
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■ Status Log: Select to receive the test status log with the notification
email. If you select this option, then also select whether you want to
receive the full log or just the last 20 lines.

NOTE. The ScoreCard and Analysis Screenshot options are not available
in Automotive Ethernet.

6. In the Email Configuration section, select as desired:

■ Enter a maximum file size for the email message. Messages with
attachments larger than this limit will not be sent. The default is 5 MB.

■ To limit the number of attempts the system makes to send a notification,
enter the number in the Number of Attempts to send field. The default is
1. You can also specify a timeout.

7. Select the Email Test Results when complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.

9. To apply your settings, click Apply button.

10. Click Close button to exit the Email Settings dialog box.

See also. Before you click start

Pre-run check list

Running the tests and viewing their progress

 Operating basics
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Setup panel

Setup panel overview The Setup panel contains sequentially ordered tabs that help you guide through
the test setup and execution process.

Figure 3: Setup panel

See also. Saving a test setup

Running the tests and viewing their progress in the Status Panel

Viewing test results in the Results Panel

Operating basics  
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Set DUT tab parameters Use the DUT tab to select parameters for the device under test. These settings are
global and apply to all tests for the current session. DUT settings also affect the
list of available tests in the Test Selection tab.

Figure 4: Setup panel

Click Setup > DUT to access the DUT parameters:

Table 9: DUT tab settings

Setting Description
DUT ID Adds an optional text label for the DUT to reports. The default value is

DUT001. The maximum number of characters is 32.
You cannot use the following characters in an ID name: (.,..,...,\,/:?”<>|*)

   Comments icon
(to the right of the DUT
ID field)

Opens a Comments dialog box in which you can enter optional text to
add to a report. Maximum size is 256 characters. To enable or disable
comments appearing on the test report. See Select report options for
details.

Acquire live waveforms Perform analysis on live waveforms.
Use pre-recorded
waveform files

Perform analysis on pre-recorded waveforms.

 Operating basics
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Setting Description
Suite ■ 1000Base-T1

■ 100Base-T1

Return Loss
measurement
preferences

■ Oscilloscope: Fully automated oscilloscope based method

■ VNA Report: Select to run the return loss measurement with a VNA
report file (S-Parameter). For steps to run the return loss
measurement by VNA Report file method, click here.

Only available, when Return Loss measurement is selected in the Test
Selection tab.

See also. Setup panel overview

Selecting tests

Setting configuration tab parameters

Selecting tests Use the Test Selection tab to select one or all the tests. The tests that you select
here impact the parameters available in the Acquisitions tab.

Figure 5: Test Selection tab

Operating basics  
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Table 10: Test selection tab settings

Setting Description
Tests Click on a test to select or unselect. Highlight a test to show

details in the Test Description pane.
Test Description Shows a brief description of the highlighted test in the test field.
Select All Click to select all the tests in the list.
Deselect All Click to deselect all the tests in the list.
Schematic Click to view the connection diagram for the selected test.

See also. Setup panel

Configuration tab

Status panel

Selecting acquisition tab
parameters

Use the Acquisitions tab to view test acquisition parameters. The contents
displayed on this tab depend on the pre-recorded or live mode selected.
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Table 11: Acquisition tab settings

Setting Description
Probe<X> Select the channel connected to the probe.
Refresh Sources Click to refresh the selected resources.
Show Acquire
Parameters

Select to view the acquisition parameters.

Signal Validation Select the signal validation type

■ Prompt me if Signal Validation Fails
■ Skip test if Signal Validation Fails
■ Use signal as is - Don't Validate

TekExpress Automotive Ethernet saves all acquisition waveforms to files by
default. Waveforms are saved in a unique folder for each session (a session starts
when you click the Start button). The folder path is X:\Automotive-Ethernet
\Untitled Session \<dutid>\<date>_<time>. Images created for each analysis,
CSV files with result values, reports and other information specific to that
particular execution are also saved in this folder.

Saving a session moves the session file contents from the Untitled Session folder
to the specified folder name, and changes the session name to the specified name.
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Acquire live waveforms for analysis. Select Acquire Live Waveforms on the
DUT tab, to perform live acquisitions. 

Figure 6: Acquisitions tab with Acquire live waveforms selected

Table 12: Acquisitions tab settings for Acquire Live Waveforms

Column name Description
Probe<x> Select the probe source channel for each listed signal in the

Probe selection drop-down menu.
Refresh Sources Click to refresh the sources.
Show Acquire Parameters Select to view the acquisition parameters for the selected tests in

the results table.
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Column name Description
Signal validation ■ Prompt me if signal fails: Select to prompt if signal fails.

 

 

■ Use Anyway: Click to Run the test on the current
acquired signal in spite of failed signal.

■ Skip Test: Click to skip the current test after signal
validation fails.

■ Reacquire: Click to reacquire the signal for the test
being Run.

■ Use signal as is-Don't check: Select to perform the test
without signal validation.

■ Skip test if signal fails:Select to skip the test for which
signal validation fails.

See also. Selecting configuration tab parameters

Use pre-recorded waveforms for analysis
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Use pre-recorded waveforms for analysis. Select Use pre-recorded waveform
files on the DUT tab, to use pre-recorded waveforms for analysis. Click  for
the selected measurement and select the waveform file (.wfm).

Figure 7: Acquisitions tab with Use pre-recorded waveform files selected

Table 13: Acquisitions tab settings for Use pre-recorded waveform files

Column name Description
Refresh Sources Click to refresh the sources.
Show Acquire Parameters Select to view the acquisition parameters for the selected tests in

the results table.

NOTE. Tektronix recommends to use a Tektronix oscilloscope to capture the
waveform files.

See also. Acquire live waveforms for analysis
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Acquire step by step. The Acquire Step By Step option is available in the
Acquisitions panel. This is a global parameter that is applied to all tests when
selected. By default, this option is deselected.

When selected, this parameter allows for display of the reference input waveform
of the selected measurement. This helps to compare the input waveform coming
from DUT with the typical reference waveform (snap shot), allowing you to
change the setup before acquiring the waveforms. The following table gives
different reference waveform snap shots that appear for different tests.

NOTE. When using prerecorded waveform files, the Acquire Step By Step option
is not available.

Table 14: Reference waveforms

Test name Reference waveform
Transmit Timing
Jitter – Master
Jitter

100Base-T1
 

 
1000Base-T1
 

 

Operating basics  

32  TekExpress Automotive Ethernet



Test name Reference waveform
Transmit Timing
Jitter – Slave Jitter

100Base-T1
 

 
1000Base-T1
 

 
Transmit Timing
Jitter – MDI Jitter

1000Base-T1
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Test name Reference waveform
Transmitter Output
Droop

100Base-T1
 

 
1000Base-T1
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Test name Reference waveform
Transmit Clock
Frequency

100Base-T1
 

 
1000Base-T1
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Test name Reference waveform
Transmitter
Distortion

100Base-T1
 

 
1000Base-T1
 

 
Transmitter Power
Spectral Density

100Base-T1
 

 
1000Base-T1
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Test name Reference waveform
Transmitter Peak
Differential Output

100Base-T1
 

 
1000Base-T1
 

 
Return Loss 100Base-T1

 

 
1000Base-T1
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Setting configuration tab
parameters

Use the Configuration tab to view the instruments detected, set measurement
parameters and perform calibration for the measurements.

Figure 8: Configure tab settings for 1000Base-T1

Figure 9: Configure tab settings for 100Base-T1
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Table 15: Configuration tab settings

Setting Description
Compliance Mode Select to use Compliance Mode values. You cannot change any test

parameters in Compliance Mode, but you can view the compliance
parameters. By default Compliance Mode is selected.

User Defined Mode Select to run tests using custom parameters.
Limits Editor Shows the upper and lower limits for the applicable measurement using

different types of comparisons.
In Compliance Mode, use the Limits Editor to view the measurement high
and low limits used for selected tests.
In User Defined Mode, use the Limits Editor to edit the limit settings.

To edit a value, click that field and either select from the displayed list or
enter a new value. Use the bottom scroll bar to view all available fields.

Global Settings
Instruments Detected Displays the instruments connected to this application. Click on the

instrument name to open a list of available (detected) instruments.
Select Options > Instrument Control Settings and click Refresh to
update the instrument list.

NOTE. Verify that the GPIB/LAN search criteria (default setting) in the
Instrument Control Settings is selected when using TekExpress
Automotive Ethernet application.

VNA Result File Click Browse. Navigate to the folder path and select a return loss result
file (s1p/s2p) generated using a Vector Network Analyser.
Only available, when Return Loss measurement is selected in the Test
Selection tab.

Apply Band-pass Filter
for Jitter Measurements

Select to apply the Band pass filter for the selected jitter measurements.
Only available, either when one among Transmitter Timing Jitter - MDI
Jitter, Transmitter Timing Jitter - Master Jitter or Transmitter Timing
Jitter - Slave Jitter measurements or all these measurements are
selected in the Test Selection tab.

NOTE. Band pass filter is applicable only for 1000Base-T1 Jitter
Measurements and it is disabled for 100Base-T1.

The Configuration screen shows Global parameters, which are common for all
tests, and Measurement parameters, which are specific to selected tests, including
acquisition, analysis, and limit parameters.
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NOTE. You cannot change the Test parameters that are greyed out.

See Also. Setup panel overview

Set DUT tab

Selecting tests

Selecting configuration tab

About saving and recalling test setups
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Measurement parameter descriptions. You can view or change the measurement
parameters in the Configuration tab of the Setup panel. Configuration parameters
are displayed for the measurement selected, in the Test Selection tab. The
parameters listed are enabled based on the measurement selected and if the
measurements are running tests in User Defined Mode. You cannot change the
parameters in Compliance Mode.

1000Base-T1

Figure 10: Measurements tab

Table 16: 1000Base-T1 measurement configurations

Name Unit Range/
Allowable
values

Default Description Applies to

Record Length M Samples 1 to 20 2.75 Sets the record
length to use.

Transmit Clock
Frequency

13 Transmitter
Timing Jitter-
MDI
Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)
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Name Unit Range/
Allowable
values

Default Description Applies to

Averages NA 2 to 100 2 Sets the
number of
averages
(number of
acquisitions)
for average
mode
acquisition.

Transmitter
Output Droop

2 to 1000 500 Return Loss

No of
Acquisitions

NA 1 to 100 5 Sets the
number of
acquisitions

Transmitter
Peak
Differential
Output

Hardware
Clock Divider

NA NA Hardware
Clock Divider

Select to use
the external
hardware clock
divider unit
(125 MHz
Tx_CLK to
10 MHz) to
synchronize
the DUT,
disturber signal
source (AWG/
AFG), and the
oscilloscope.

Transmitter
Distortion

Software
Signal
Correction

NA NA NA When Software
Signal
correction
method is
selected, the
software
computes Tx
distortion for
TM4 signal
with disturber
source without
using hardware
CDU
synchronizatio
n.

Transmitter
Distortion

None NA NA NA Select to check
the behavior of
the DUT
without any Ref
clock (External
or Internal).

Transmitter
Distortion
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Name Unit Range/
Allowable
values

Default Description Applies to

Unit of
Measurement

■ dBm
■ dBm/Hz

NA NA dBm Selects the unit
of
measurement
on which
Transmitter
Power Spectral
Density will be
displayed.

Transmitter
Power Spectral
Density and
Power Level

Edge

■ Falling
■ Rising

NA NA Rising Used to select
the type of
edges on
which RMS
Jitter and
Peak-to-Peak
Jitter will be
calculated.

Transmitter
Timing Jitter-
MDI Jitter
Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)

Hysteresis % 1 to 10 5 Sets the
hysteresis in
percentage
that gets used
during edge
finding.

Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)
Transmitter
Timing Jitter -
MDI Jitter

Smooth NA 0 to 10 7 Sets the
number of
samples that
will be used
while
smoothing the
return loss
waveform; sets
the averaging
filter length.

Return Loss

100Base-T1
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Table 17: 100Base-T1 measurement configurations

Name Unit Range/
Allowable
values

Default Description Applies to

Record Length M Samples 1 to 20 0.5 Sets the record
length to use.

Transmit Clock
Frequency

12.5 Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)

Averages NA 2 to 100 16 Sets the
number of
averages
(number of
acquisitions)
for average
mode
acquisition.

Transmitter
Output Droop2 to 1000 500 
Return Loss

Spectral
Average

NA 2 to 256 2 Sets the
number of
spectral
averages

Transmitter
Power Spectral
Density
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Name Unit Range/
Allowable
values

Default Description Applies to

Hardware
Clock Divider

NA NA NA Select to use
the external
hardware clock
divider unit
(66.66 MHz
Tx_CLK to
10 MHz) to
synchronize
the DUT,
disturber signal
source (AWG/
AFG), and the
oscilloscope.

Transmitter
Distortion

Software
Signal
Correction

NA NA NA When Software
Signal
correction
method is
selected, the
software
computes Tx
distortion for
TM4 signal
with disturber
source without
using hardware
CDU
synchronizatio
n.

Transmitter
Distortion

None NA NA NA Select to check
the behavior of
the DUT
without any Ref
clock (External
or Internal).

Transmitter
Distortion

Edge

■ Falling
■ Rising

NA NA Rising Used to select
the type of
edges on
which RMS
jitter will be
calculated.

Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)

Hysteresis % 1 to 10 5 Sets the
hysteresis in
percentage
that gets used
during edge
finding.

Transmitter
Timing Jitter
(Master Jitter)
Transmitter
Timing Jitter
(Slave Jitter)
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Name Unit Range/
Allowable
values

Default Description Applies to

RBW KHz 1 to 100 10 Sets the
resolution
bandwidth.
This controls
the bandwidth
of the spectral
analyzer filters.

Transmitter
Power Spectral
Density

Center
Frequency

MHz 50 to 500 100.5 Sets the center
of the
frequency span
over which
spectral
analysis is
done.

Transmitter
Power Spectral
Density

Frequency
Span

MHz 100 to 500 201 Sets the range
of frequencies
over which
spectral
analysis is
done

Transmitter
Power Spectral
Density

Unit of
Measurement

■ dBm
■ dBm/Hz

NA NA dBm Selects the unit
of
measurement
on which
Transmitter
Power Spectral
Density will be
displayed.

Transmitter
Power Spectral
Density

Smooth NA 0 to 10 7 Sets the
number of
samples that
will be used
while
smoothing the
return loss
waveform; sets
the averaging
filter length.

Return Loss

See also. Setting configuration tab parameters
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Calibration. Calibration step is done to calibrate the disturber signal source
amplitude and frequency. It measures the DUT signal level at defined PIN points
on the test fixture. You can perform calibration on live DUT signal and disturber
source signal connected as mentioned in the calibration connection diagram.

NOTE. It is recommended to do calibration of the waveforms for Transmitter
Distortion and Return Loss measurements.

Calibration for transmitter distortion measurement

Figure 11: Calibration tab for 1000Base-T1 transmitter distortion measurement
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Figure 12: Calibration tab for 100Base-T1 transmitter distortion measurement

Calibration for return loss measurement

Figure 13: Calibration tab for return loss measurement
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Table 18: Calibration settings

Parameter Description
Live Calibration Sets the live calibration process. The live Calibration files are

saved in X:\Automotive Ethernet\Calibration folder.
Use Pre-recorded Calibration Sets the calibration process with prerecorded calibrated

waveforms and allows you to browse and select the calibrated
waveforms. The path for selecting the calibrated waveforms is C:
\Users\Public\Tektronix\TekApplications\Automotive-Ethernet.

Channel drop down Allows you to select relevant channel and probes.

NOTE. when you change the input sources (Channel) other than
calibrated sources, you need to re-calibrate with latest sources.

Cal Type Displays the type of calibration: Load, Open, and Short.
Cal Status Displays the status of the calibration: Pending, Done.
Cal Time Displays the previous calibration time: Date, Month, and Year.
Schematic Click to view the schematic.
Plot Click to view the plot.
Apply Click to apply the configured parameters to calibration.
Run Click to run the process of calibration.
Default button Click to perform calibration by using default values.

NOTE. This button is applicable only for Transmitter distortion.
The expected and measured values for Transmitter distortion on
Calibration tab will be initially empty, when you launch the
application for the first time and they get populated once you
click the Default button.

To manually set up signal
source: Click here and copy
files to USB drive and recall on
connected signal source.

In case of manual signal source (AFG/AWG) setup, click the link
and copy the relevant folder and recall the setup on connected
signal source.

Compliance mode or User defined mode. From the Configuration screen, you will
have the option to select either Compliance Mode or User Defined Mode.

■ Compliance Mode: Select to use Compliance Mode values. You cannot
change any test parameters in Compliance Mode, but you can view the
compliance parameters.

■ User Defined Mode: Select to run tests using custom parameters. You may
change parameters that are not grayed out.
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Set preferences tab
parameters

Use the Preferences tab to set the application action on completion of a
measurement.
 

 

Table 19: Preferences tab settings

Setting Description
Number of Runs
Acquire/Analyze each test Select to run the same selected test(s), specified number of

times. Minimum is two. Maximum is 30.
Actions on Test Measurement Failure
On Test Failure, stop and notify
me of the failure

Select to stop the test run on Test Failure, and to get notified via
email. By default, it is unselected.
Click Email Settings to configure.

Logging Options
Enable Logging Select to enable/disable the logging feature. When enabled the

application records the actions of the user. By default, it is
selected.
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Setting Description
Hide schematic popup while
running the test (for single test
selection only)

When selected the schematic popup is displayed.

NOTE. When more than one test is selected, a warning message
will be displayed and the enabled check box will be ignored. The
schematics will be displayed for the selected measurements.
Does not apply for exceptions, VISA-connection timeout pop-ups.

 

 

Status panel overview
The Status button accesses the Test Status and Log View tabs, which provide
status on test acquisition and analysis (Test Status tab) and a listing of test tasks
performed (Log View tab). The application opens the Test Status tab when you
start a test run. You can select the Test Status or the Log View tab to view these
items while tests are running. 

Test status view
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Log view

Table 20: Status panel Log View controls

Control Description
Message History Lists all executed test operations and timestamp

information.
Auto Scroll Enables automatic scrolling of the log view as

information is added to the log during the test.
Clear Log Clears all messages from the log view.
Save Saves the log file to a text file. Use the standard

Save File window, to navigate and specify the
folder and file name and then save the log file.
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Results panel

Viewing test results: the
Results panel

When a test completes running, the application switches to the Results Panel.

Set result viewing preferences from the Preferences menu in the upper right
corner.

Each test result occupies a row in the Results table. By default, results are
displayed in summary format, with the measurement details collapsed, and with
the Pass/Fail column visible. You can change the display view.

■ To expand all test rows listed, from the Preferences menu in the upper right
corner, select View Results Details.

■ To expand a collapsed test row, click the plus button ( ) to the left of the
test row.

■ To collapse all expanded test rows, select Preferences > View Results
Summary.

■ To collapse a single expanded test row, click the minus button ( ) to the left
of the test row.

■ To remove or restore the Pass/Fail column, select Preferences > Show Pass/
Fail.

■ To enable or disable the wordwrap feature, select Preferences > Enable
Wordwrap.

■ To expand the width of a column, place the cursor over the vertical line that
separates the column from the one to the right. When the cursor changes to a
double-ended arrow, hold down the mouse button and drag the column to the
desired width.

■ To sort the test information by column, click the column head. When sorted
in ascending order, a small up arrow is displayed. When sorted in descending
order, a small down arrow is displayed.

■
To clear all test results displayed, click Clear  button.
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Results preferences

Figure 14: Results preferences

See also. Setup panel

Running tests and viewing their progress: the Status panel

View test-related Files Files related to TekExpress Automotive Ethernet tests are stored in the X:
\Automotive Ethernet\Untitled Session shared folder. In the Automotive Ethernet
folder, each test setup has a test setup file and a test setup folder, both with the
test setup name. The test setup file is preceded by the Automotive Ethernet icon
and usually has no file extension displayed.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions (the default is DUT001).

Inside the DUT001 folder are the session folders and files. Each session has a
folder and file pair, both named for the test session using the naming convention
(date)_(time). Each session file is stored outside of its matching session folder.
 

 

Each session folder contains image files of any plots generated by the test session
and any waveform files if prerecorded waveform files were used during the
session.
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The first time you run a new, unsaved session, the session files are stored in the
X:\Automotive Ethernet\Untitled Session folder. Once you name and save the
session, the Untitled Session folder name is changed to the one you specified.

NOTE. By default, test report files are saved in the session folder. You can change
the report file location for a specific test.

See also. File name extensions

Plots panel

Viewing plots The Plots panel displays a summary of plot generated during run. The plots have
zoom, cursors, save, dock/undock, and select test features.

Types of plots

Following are different plots generated during run, based on the measurement(s)
selected.

Transmit Clock Frequency

Figure 15: Transmit Clock Frequency - 1000Base-T1 Histogram Plot

 Operating basics

TekExpress Automotive Ethernet 55



Figure 16: Transmit Clock Frequency - 1000Base-T1

Figure 17: Transmit Clock Frequency - 100Base-T1
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Transmitter Timing Jitter (Master and Slave)

Figure 18: Master Jitter - 1000Base-T1 Histogram plot

Figure 19: Master Jitter - 1000Base-T1
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Figure 20: Master Jitter - 100Base-T1

Figure 21: Slave Jitter - 1000Base-T1 Slave Histogram plot
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Figure 22: Slave Jitter - 1000Base-T1

Figure 23: Slave Jitter - 100Base-T1
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Transmitter Output Droop

Figure 24: Transmitter Output Droop - 1000Base-T1: Positive

Figure 25: Transmitter Output Droop - 1000Base-T1: Negative
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Figure 26: Transmitter Output Droop - 100Base-T1: Positive

Figure 27: Transmitter Output Droop - 100Base-T1: Negative

 Operating basics

TekExpress Automotive Ethernet 61



Transmitter Power Spectral Density

Figure 28: Transmitter Power Spectral Density and Power Level - 1000Base-T1

Figure 29: Transmitter Power Spectral Density - 100Base-T1
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Transmitter Distortion

Figure 30: Error Value - 1000Base-T1

Figure 31: Error Value - 100Base-T1
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Figure 32: Peak Distortion - 1000Base-T1

Figure 33: Peak Distortion - 100Base-T1
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Return Loss

Figure 34: Return Loss - 1000Base-T1

Figure 35: Return Loss - 100Base-T1
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Figure 36: 100Base-T1 Return Loss Load Calibration

Figure 37: 100Base-T1 Return Loss Short Calibration
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Figure 38: 100Base-T1 Return Loss Open Calibration

Figure 39: 1000Base-T1 Return Loss Load Calibration
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Figure 40: 1000Base-T1 Return Loss Short Calibration

Figure 41: 1000Base-T1 Return Loss Open Calibration

See also. Known limitations
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Reports panel

Reports panel overview Use the Reports panel to browse for reports, name and save reports, select test
content to include in reports, and select report viewing options.

Figure 42: Reports panel

For information on setting up reports, see Select report options. For information
on viewing reports, see View a report.

Report contents A report shows detailed results and plots, as set in the Reports panel.
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Figure 43: Example report for single run
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Figure 44: Example report for multi-run

Setup configuration information

The summary box at the beginning of the report lists setup configuration
information. This information includes the oscilloscope model and serial number,
optical module model and serial number, and software version numbers of all
associated applications.

To exclude this information from a report, clear the Include Setup
Configuration check box in the Reports panel before running the test.

User comments

If you selected to include comments in the test report, any comments you added
in the DUT tab are shown at the top of the report.
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See also. Results panel

View test-related files

Select report options Click the Reports button and use the Reports panel controls to select which test
result information to include in the report, and the naming conventions to use for
the report. For example, always give the report a unique name or select to have
the same name increment each time you run a particular test.

Select report options before running a test or when creating and saving test
setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:

Table 21: Report options

Setting Description
Report Update Mode
Generate new report Creates a new report. The report can be in

either .mht or .pdf or .csv file formats.
Append with previous run session Appends the latest test results to the end of the

current test results report.
Replace current test in previous run session Replaces the previous test results with the latest

test results. Results from newly added tests are
appended to the end of the report.

Report Creation Settings
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Setting Description
Report name Displays the name and location from which to

open a Ethernet Tx report. The default location
is at \My TekExpress\Automotive Ethernet
\Untitled Session. The report file in this folder
gets overwritten each time you run a test unless
you specify a unique name or select to auto
increment the report name.
Change the report name or location.

Do one of the following:

■ In the Report Path field, type over the
current folder path and name.

■ Double-click in the Report Path field and
then make selections from the popup
keyboard and click the Enter button.

Be sure to include the entire folder path, the file
name, and the file extension. For example: C:
\Documents and Settings\your user name\My
Documents\My TekExpress\Automotive Ethernet
\DUT001.mht.

NOTE. You cannot set the file location using the
Browse button.

Open an existing report.
Click Browse, locate and select the report file
and then click View at the bottom of the panel.

Save as type Saves a report in the specified file type, selected
from the drop-down list.

NOTE. If you select a file type different from the
default, be sure to change the report file name
extension in the Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUT002,
DUT003. This option is enabled by default.

Create report automatically at the end of the run Creates report at the end of the run.
Contents To Save
Include pass/fail info in details table Includes pass/fail info in the details table of the

report.
Include detailed results Includes detailed results in the report.
Include plot images Includes plot images in the report.
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Setting Description
Include setup configuration Sets the application to include hardware and

software information in the summary box at the
top of the report. Information includes: the
oscilloscope model and serial number, the
oscilloscope firmware version, and software
versions for applications used in the
measurements.

Include complete application configuration Includes complete application configuration in
the report.

Include user comments Select to include any comments about the test
that you or another user added in the DUT tab of
the Setup panel. Comments appear in the
Comments section, under the summary box at
the beginning of each report.

Group Report By
Test Name Select to group the tests in the report by test

name.
Test Result Select to group the tests in the report by test

results
View report after generating Automatically opens the report in a Web browser

when the test completes. This option is selected
by default.

View Click to view the most current report.
Generate Report Generates a new report based on the current

analysis results.
Save As Specify a name for the report.

View a report The application automatically generates a report when test analysis is completed
and displays the report in your default Web browser (unless you cleared the View
Report After Generating check box in the Reports panel before running the
test). If you cleared this check box, or to view a different test report, do the
following: 

1. Click the Reports button.

2. Click the Browse button and locate and select the report file to view.

3. In the Reports panel, click View.

For information on changing the file type, file name, and other report options, see 
Select report options.
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Running tests

Automate AWG/AFG signal generation
The TekExpress Automotive Ethernet application allows you to automatically
load the pattern files in AWG/AFG and generate the signals. Ensure that the
GPIB/LAN/USB connection between the oscilloscope and AWG/AFG is
established, before you automate the signal generation. The AWG/AFG
automation is supported for the following measurements:

■ Transmitter Distortion with disturbing signal: AWG/AFG is used to transmit
a disturbing signal. CH1 and CH1_inverted are used.

■ Return Loss measurement and calibration: AWG/AFG is used to transmit a
wide band signal. CH1 and CH1_inverted are used for transmission of the
signal. A marker signal has to be connected to the auxiliary channel of the
oscilloscope (used as trigger source).

How to automate AWG/AFG signal generation

Complete the following steps in the TekExpress application to automate the
signal generation from AWG/AFG:

1. Click in the upper right corner of the application and select Instrument
Control Settings.

2. Select Search Criteria as USB and click Refresh; when the Retrieved
Instruments table is uploaded with the connected instruments list, click
Close.

Figure 45: Instrument Control Settings
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3. Once the AWG/AFG is listed as shown above, go to the Global Settings tab
from the Configuration menu of the Tests. If the AWG/AFG is supported, it
will be listed as a drop-down menu option next to the Automate with AWG/
AFG label. By default, the application will consider the connected AWG to
be used for automation.

Figure 46: Test Selection tab

NOTE. If Automate with AWG/AFG is set as Do not use, you must manually copy
the AWG/AFG waveforms from the oscilloscope to the AWG/AFG. Waveforms
are located at C:\Program Files\Tektronix\TekExpress\TekExpress Automotive-
Ethernet\AWG Waveforms\.
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Before you click start
Before running a test for the first time

Before you run a test for the first time, review these steps:

1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress Automotive Ethernet, it creates the
following folders on the Oscilloscope:

■ \Program Files\Tektronix\TekExpress\TekExpress Automotive-Ethernet

■ \My Documents\My TekExpress\Automotive Ethernet

■ \My Documents\My TekExpress\Automotive Ethernet\Untitled Session

Every time you launch TekExpress Automotive Ethernet.exe, an Untitled
Session folder is created in the Automotive Ethernet folder. The Untitled
Session folder is automatically deleted when you exit the Automotive
Ethernet application.

CAUTION. Do not modify any of the session files or folders because this may
result in loss of data or corrupted session files. Each session has multiple files
associated with it. When you save a session, a .TekX file, and a folder named for
the session that contains the associated files, is created on the oscilloscope X:
drive.

2. Ensure that the My TekExpress folder has read and write access, and that
the contents are not set to be encrypted:

a. Right-click the folder and select Properties.

b. Select the General tab, and then click Advanced.

c. In the Advanced Attributes dialog box, ensure that the option Encrypt
contents to secure data is NOT selected.
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Example:

Figure 47: Advanced Attributes dialog box

Before running any test

1. Review the Pre-run check list.

2. Configure the Email notification options if you want the application to notify
you by email when a test completes or produces an error. Access the email
options either from the Options menu in the upper right corner, or from the
Preferences tab on the Setup panel.

3. Select the Report options.

See Also

Pre-run check list
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Pre-run check list
Do the following before you click Start to run a test. If this is the first time you
are running a test on a setup, then refer also to the guidelines above.

1. Ensure that all the required instruments are properly warmed up (about
20 minutes).

2. Perform the Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.

b. Select Instrument Calibration.

3. Deskew any cables.

4. Ensure that the application is able to find the DUT. If it cannot, perform a
search for connected instruments.

To find the DUT:

a. Launch the TekExpress Automotive Ethernet application.

b. Select the Setup panel and then click the DUT tab.

c. Click the Test Selection tab. Select any test, and then click Configure
button.

d. In the Configuration section, click Global Settings.

e. In the Instruments Detected section, click in the shaded area opposite Real
Time Scope and ensure that the oscilloscope with the (GPIB8::1::INSTR)
designation is in the drop-down list.

See also Before you click start

Configure email notification

Running the tests and viewing their progress
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Running the tests and viewing their progress: the Status panel
Once you have configured the tests and gone through the Pre-run check list, from
any screen, click the green Start button. The application acquires and analyzes
the data, then displays a report when the tests are completed.

While the tests are running, other applications may display windows in the
background. The TekScope application takes precedence over other applications,
but you can switch to other applications using the Alt+Tab key combination. To
keep the TekExpress Automotive Ethernet application on top, select the Keep On
Top from the Options menu in the upper right corner.

Viewing the progress of
analysis

The Status panel displays a record of the test as it is executed. By default, the
application switches to this panel after you click the Start button to run a test.
You can choose from the following two views by selecting the named tab, even
while a test is in progress:

Test Status tab

Figure 48: Test status tab

The Test Status tab presents a collapsible table with information about each test
as it is running. To collapse and expand the table rows, click the expand ( )/( )
collapse button.
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Table 22: Test Status table headers

Column Description
Test Name Name of the test
Acquisition Describes the type of data being acquired
Acquire Status Progress of the acquisition:

■ To be started

■ Started Acquisition

■ Completed Acquisition

Analysis Status Progress state of the analysis:

■ To be started

■ In Progress

■ Completed

■ Aborted

■ Skipped

Log View tab

Figure 49: Log view

The Log View tab provides a list of actions that happen as the test executes. You
can use this tab to review or troubleshoot tests.
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Table 23: Log view options

Item Description
Message History This window time-stamps and displays all run

messages.
Auto Scroll Select this check box to have the program

automatically scroll down as information is
added to the log during test execution.

Clear Log Click this button to clear all messages in the
Message History area.

Save Use to save the log file as a text file for
examination. Displays a standard Save File
window and saves the status messages file that
you specify.

See also Before you click start

Pre-run check list

Configure email notification
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Saving and recalling test setups

About saving and recalling test setups
TekExpress Automotive Ethernet application opens with the default test setup
selected. Any time you want to create a new test setup, you can select the default
test setup to clear the previous test setup selections and take the settings back to
their defaults.

You can run a test before or after saving a setup. When you save a setup, the
selected oscilloscope, general parameters, acquisition parameters, measurement
limits, prerecorded waveform files (if applicable), test, and other configuration
settings are all saved under the setup name. You can open a setup and click Start
button without having to do any other setting up except ensuring that the
oscilloscope is detected and ready. For details, see Before you click start.

See Also Save a test setup

Recall a saved test setup

Create a new test setup based on an existing one

Delete a test setup

Setup panel overview
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Saving a test setup
Save a test setup before or after running a test using the parameters you want to
be saved. You can create a new setup from any setup you have open or from the
default setup. When you select the default test setup, all parameters are returned
to their defaults. The following instructions start from the default setup:

1. From the Options menu, select Default Test Setup.

2. Select the desired options in the Setup panel.

3. Select the desired report options.

4. If desired, run the test to ensure that it captures the information you want. If it
does not, edit the parameters.

5. From the Options menu, select Save Test Setup.

6. Name the test and, then click Save button.

See Also About test setups

Recall a saved test setup

Create a new test setup based on an existing one

Delete a test setup

Recalling a saved test setup
These instructions are for recalling saved test setups.

1. From the Options menu, select Open Test Setup.

2. In the File Open dialog box, select the desired setup from the list, and then
click Open button.

See also

About test setups

Save a test setup

Create a new test setup based on an existing one

Delete a test setup
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Creating a new test setup based on an existing one
Use this method to create a variation on a test setup without having to create the
setup from the beginning.

1. From the Options menu, select Open Test Setup.

2. In the File Open dialog box, select the desired setup from the list, and then
click Open.

3. Modify the parameters as desired.

4. From the Options menu, select Save Test Setup As.

5. In the File Save As dialog box, enter a test setup name, and then click Save.

See also

About test setups

Save a test setup

Recall a saved test setup

Delete a test setup

Deleting a test setup
If you no longer need a test setup, delete it from the test setup list in the Options
menu using these instructions.

Each saved test setup consists of two main parts, the test setup file and the test
setup folder, both named for the test session.

1. Ensure the setup you want to delete is not currently selected in TekExpress
Automotive Ethernet.

2. Navigate to the Automotive Ethernet folder where test setup files are stored.
For example, X:\Automotive Ethernet\(test setup name).

3. Locate the test setup file, and then delete it.

This removes the setup from the list in the Options menu.

4. Locate the test setup folder. If you want to keep any of the session files,
move them out of the test setup folder and then delete the test setup folder.

See also

About test setups

Save a test setup

Recall a saved test setup

Create a new test setup based on an existing one
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Automotive Ethernet measurements

Transmitter clock frequency
This measurement verifies that the frequency of the transmit clock is within the
conformance limits.

Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.6 Transmitter clock
frequency test.

100Base-T1 BroadR-Reach Physical Layer Transceiver
Specification for Automotive Applications,
version 3.2, section 5.1.3 or IEEE P802d3bwTM

(100 Base T1) section 96.5.4.5 transmitter
specifications
BroadR-Reach Physical Media Attachment Test
Suite version 2.0, section 5.5 

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ One supported differential probe

■ Short automotive cable.

■ TF-XGbT test fixture
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Figure 50: Connection diagram

NOTE. Ensure that the probe tip (+) is connected to the  on the text fixture
board.

Test setup procedure
1. Make the connection as shown in the above connection diagram.
2. Select the Suite type on the DUT panel.
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3. Set the DUT to generate and transmit test mode 2 signal for 1000Base-T1
and 100Base-T1.

4. Connect the DUT Ethernet cable to J5 Ethernet port (TC1 segment) of TF-
XGbT test fixture.

5. Connect the differential probe to P12 and the configured channel of the
oscilloscope and also terminate the SMA pins J11 and J13 with 50 Ω
terminators.

6. Compute and verify the clock frequency between the High and Low limits as
shown in below table.

NOTE.
■ 1000Base-T1: The test mode 2 signal is a clock signal where the PHY shall

transmit a continuous pattern of three {+1} symbols followed by three {–1}
symbols with the transmitted symbols timed from its local clock source of
750 MHz. 1000Base-T1 PHY shall provide access to a frequency reduced
version of the transmit symbol clock or TX_TCLK125. This 125 MHz test
clock is one sixth frequency divided version of TX_TCLK that times the
transmitted symbols.

■ 100Base-T1: The test mode 2 signal is a clock signal where the PHY shall
transmit the data symbol sequence (+1, -1) repeatedly on all channels.

Item Requirements
Signal type Test mode 2 for 1000Base-T1 (125 MHz +/- 100 ppm)

 

 
Test mode 2 for 100Base-T1(66.667 MHz +/- 100 ppm)
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Measurement output

Lower limit Upper limit
100Base-1 Clock frequency 66.6603 MHz 66.6736 MHz

Number of unit intervals
1000Base-T1 Transmit clock

frequency
124.9875 MHz 125.0125 MHz

Transmit symbol
frequency

749.9250 MHz 750.0750 MHz

See also Plots

Transmitter timing Jitter-MDI Jitter
This measurement verifies that the transmitter timing jitter - master of the PMA
is within the conformance limits.

Suite Specification
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.3 Transmitter Timing Jitter-
MDI Jitter.

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ One supported differential probe

■ Short automotive cable.

■ TF-XGbT test fixture

Test setup procedure

1. Make the connection as shown in the below connection diagram.

2. Select the Suite type on the DUT panel.

3. Set the DUT to generate and transmit test mode 2 signal for 1000Base-T1.

4. Connect the DUT Ethernet cable to J5 Ethernet port (TC1 segment) of TF-
XGbT test fixture.

5. Connect the differential probe to P12 and the configured channel of the
oscilloscope and also terminate the SMA pins J11 and J13 with 50 Ω
terminators.
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NOTE. Test mode 2 is for Transmitter Jitter testing on MDI when transmitter is in
MASTER timing mode. When test mode 2 is enabled, the 1000Base-T1 PHY shall
transmit a continuous pattern of three {+1} symbols followed by three {–1}
symbols with the transmitted symbols timed from its local clock source of
750 MHz. The transmitter output is a 125 MHz signal.

Figure 51: Connection diagram
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NOTE. Ensure that the probe tip (+) is connected to the  on the text fixture
board.

Lower Limit Upper Limit
1000Base-T1 MDI Jitter RMS NA 5 pico seconds

MDI Jitter peak to peak NA 50 pico seconds

See also Plots

Transmitter timing jitter - Master Jitter and Slave Jitter
This section verifies that the transmitter timing jitter (master and slave) of the
PMA is within the conformance limits.

Suite Specification
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.3 Transmitter Timing Jitter-
MDI Jitter.

100Base-T1 BroadR-Reach Physical Layer Transceiver
Specification for Automotive Applications,
version 3.2, section 5.4.3 or IEEE P802d3bwTM
(100 Base T1) section 96.5.4.3 transmitter
specifications
BroadR-Reach Physical Media Attachment Test
Suite version 2.0, section 5.3 

Required test equipment

In addition to the DUT and oscilloscope, you will need the following:

■ One supported differential probe.

■ Short automotive cable.

■ Test Fixture: TF-XGbT

■ Link partner (to put the DUT to slave mode)
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NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

Figure 52: Connection diagram for 1000Base-T1 timing jitter (master) test
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Figure 53: Connection diagram for 100Base-T1 timing jitter (master) test

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.
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Test setup procedure for timing jitter (master) test

1. Connect the equipment as shown in the connection diagram for
100/1000Base-T1 timing jitter (master) test.

2. Select the suite type on the DUT panel.

3. Set the DUT to generate and transmit a test mode 2 signal for 100Base-T1
and test mode 1 signal for 1000Base-T1.

For 100Base-T1

■ Connect the DUT ethernet cable to J5 ethernet port (TC1 segment) of TF-
XGbT test fixture.

■ Connect the differential probe to P12 and the configured channel of the
oscilloscope.

Connect the DUT ethernet cable to J5 ethernet port (TC1 segment) of TF-
XGbT test fixture.

■ Terminate the SMA pins J11 and J13 with 50 Ω terminators.

For 1000Base-T1

■ Connect the DUT Master-Slave configuration.

■ Connect the SMA/BNC cable from the exposed TX_TCLK125 clock pin to
run the measurement with 1000 Base-T1 MASTER TX_TCLK125 signal.

Figure 54: Connection diagram for Jitter (Slave) test

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.
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Test setup procedure for timing jitter (slave) test

1. Connect the equipment as shown in the above connection diagram.

2. Select the Suite type on the DUT panel

3. 100Base-T1: The SLAVE transmitter timing jitter can only be performed
when the DUTs TX_TCLK is exposed and accessible. For normal operation
as the SLAVE, the DUTs reference clock is recovered from a compliant LP
PHY operating as MASTER. The RMS TIE jitter of the SLAVE TX_TCLK
shall not exceed 0.01 UI (150 ps).

1000Base-T1: When configured for test mode 1 the DUT is in normal
operation but a reduced version of the transmit symbol clock
(TX_TCLK125) is exposed for testing purposes. The TX_TCLK125 signal is
a 125 MHz signal, and the RMS TIE jitter measured on the TX_TCLK125
when the DUT is configured as SLAVE shall be less than 10 ps.
Additionally, the Peak-to-Peak TIE jitter measured on the TX_TCLK125
when the DUT is configured as MASTER shall be less than 100 ps. The jitter
is measured over an integration time interval of at least 1 ms.

4. Connect the DUT to the link partner and establish a normal Ethernet
connection.

5. Use the appropriate cable or probe to run the measurement with the 100Base-
T1 DUT SLAVE TX_TCLK or 1000Base-T1 DUT SLAVE TX_TCLK125
signal.

NOTE. You can perform slave transmitter timing jitter only when the
100Base-T1 DUT SLAVE TX_TCLK or 1000Base-T1 DUT SLAVE
TX_TCLK125 is exposed and accessible.
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Item Requirements
Signal type Test mode 1 (master) and SLAVE TK_TCLK125 (slave) for

1000Base-T1
 

 
 

 
Test mode 2 (master) and SLAVE TK_TCLK125 (slave) for
100Base-T1
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Table 24: Limits

Lower limit Upper limit
1000Base-T1 Master Jitter RMS NA 5 ps

Master Jitter peak-to-
peak

NA 50 ps

Slave Jitter RMS NA 10 ps
Slave Jitter peak-to-
peak

NA 100 ps

100Base-T1 Master Jitter RMS NA 50 ps
Slave Jitter RMS NA 150 ps

See also Plots

Transmitter power spectral density
This measurement verifies that the transmitter power spectral density is within
the conformance limits.

Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.4 Transmitter Power
Spectral Density and Power Level. The
measurement also verifies if the transmit power
of the test mode signal is less than 5 dBm.

100Base-T1 BroadR-Reach Physical Layer Transceiver
Specification for Automotive Applications,
version 3.2, section 5.4.4 or IEEE P802d3bwTM
(100 Base T1) section 96.5.4.4 transmitter
specifications.
BroadR-Reach Physical Media Attachment Test
Suite version 2.0, section 5.4.

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ One supported differential probe

■ Short automotive cable.

■ TF-XGbT test fixture
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Test name Requirements
Signal type 100Base-T1

 

 
1000Base-T1
 

 

Test setup procedure

1. Make the connection as shown in the below connection diagram

2. Select the Suite type on the DUT panel.

3. Set the DUT to generate and transmit test mode 5 signal.

4. Connect the DUT Ethernet cable to J5 Ethernet port (TC1 segment) of TF-
XGbT test fixture.

5. Connect the differential probe to P12 and the configured channel of the
oscilloscope and also terminate the SMA pins J11 and J13 with 50 Ω
terminators.
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Figure 55: Connection diagram for power spectral density

NOTE. Ensure that the probe tip (+) is connected to the  on the text fixture
board.
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Power spectrum curve
mask information

Table 25: Power spectrum curve mask information for 100Base-T1

Frequency PSD Upper Bound (dBm) PSD Lower Bound (dBm)
at 1 MHz –23.3 –30.9 
at 20 MHz –24.8 –35.8 
at 40 MHz –28.5 –40.2 
57 MHz - 200 MHz –36.5 – NA

Power spectrum curve mask information for 1000Base-T1
 

 

Upper and lower limits/masks are piece-wise linear masks connecting points
given in the above table.

Measurement Suite Lower limit Upper limit
Power Level 1000Base-T1 NA 5 dBm

Mask Figure 56: Mask for 1000Base-T1 PSD

 

 Automotive Ethernet measurements

TekExpress Automotive Ethernet 103



 

Figure 57: Mask for 100Base-T1 PSD

 

 

See also Plots
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Transmitter output droop
This measurement verifies that the transmitter output level does not decay faster
than the maximum specified rate.

Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.1 Transmitter Output
Droop.

100Base-T1 BroadR-Reach Physical Layer Transceiver
Specification for Automotive Applications,
version 3.2, section 5.4.1 or IEEE P802d3bwTM
(100 Base T1) section 96.5.4.1 transmitter
specifications.
BroadR-Reach Physical Media Attachment Test
Suite version 2.0, section 5.1 

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ One supported differential probe

■ Short automotive cable.

■ TF-XGbT test fixture
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Item Requirements
Signal type 100Base-T1

 

 
1000Base-T1
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Figure 58: Connection diagram for Transmitter output droop

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

Test setup procedure
1. Make the connection as shown in the above connection diagram.
2. Select the Suite type on the DUT panel.
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3. Set the DUT to generate and transmit test mode 1 for 100Base-T1 and test
mode 6 signal for 1000Base-T1.

4. Connect the DUT Ethernet cable to J5 Ethernet port (TC1 segment) of TF-
XGbT test fixture.

5. Connect the differential probe to P12 and the configured channel of the
oscilloscope and also terminate the SMA pins J11 and J13 with 50 Ω
terminators.

Automotive Ethernet
standard

Droop type Lower limit Upper limit

100Base-T1 Positive Output Droop
Percentage

NA 45%

Negative Output Droop
Percentage

NA 45%

1000Base-T1 Positive Output Droop
Percentage

NA 10%

Negative Output Droop
Percentage

NA 10%

Transmitter peak differential output
This measurement verifies that the transmitter output level does not decay faster
than the maximum specified rate.

1000Base-T1

When measured with 100 Ohm termination, transmit differential signal at MDI
shall be less than 1.30 V peak-to- peak. This limit applies to Test Mode 5.

100Base-T1

When measured with 100 Ohm termination, this test confirms that the transmitter
peak differential output is within 2.2 V peak-to-peak limits. This limit applies to
test mode 5.

1. This measurement uses the test mode 5 signal for Peak Differential Output
measurement.

2. Measurement acquires multiple test signals, which are defined on the
Configuration tab. You can modify the values in the User Define Mode.
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3. This test uses the Histogram peak-to-peak measurement to compute the peak-
to-peak value. The histogram is being built over the defined number of
acquisitions and compute the results.

 

1000Base-T1

100Base-T1

Figure 59: Vertical Histogram for Peak Differential Output
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Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameter for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.5 Transmitter Peak
Differential Output.

100Base-T1 ■ IEEE Draft P802.3bw/ D3.3, section
96.5.6 transmitter specifications

■ BroadR-Reach Physical Media Attachment
Test Suite version 1.0, section 5.8 

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ One supported differential probe

■ Short automotive cable.

■ TF-XGbT test fixture

Test name Requirements
Signal type 100Base-T1

 

 
1000Base-T1
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Figure 60: Connection diagram for peak differential output

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

Test setup procedure
1. Make the connection as shown in the above connection diagram.
2. Select the Suite type on the DUT panel.
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3. Set the DUT to generate and transmit test mode 5 signal.
4. Connect the DUT Ethernet cable to J5 Ethernet port (TC1 segment) of TF-

XGbT test fixture.
5. Connect the differential probe to P12 and the configured channel of the

oscilloscope and also terminate the SMA pins J11 and J13 with
50 terminators.

Table 26: Limits table for 100Base-T1 and 1000Base-T1

Low Limit High Limit
100Base-T1 NA 2.2 V (peak-to-peak)
1000Base-T1 NA 1.3 V (peak-to-peak)

Transmitter distortion
This measurement verifies that the peak distortion values, measured at a
minimum of 10 equally spaced phases of a single symbol period, shall be less
than 15 mV.

Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std

802.3bp™-2016) a parameters for 1 Gb/s
Operation over a Single Twisted-Pair Copper
Cable section 97.5.3.2 Transmitter Distortion
test.

100Base-T1 BroadR-Reach Physical Layer Transceiver
Specification for Automotive Applications,
version 3.2, section 5.4.2 or IEEE P802d3bwTM
(100 Base T1) section 96.5.4.2 transmitter
specifications
BroadR-Reach Physical Media Attachment Test
Suite version 2.0, section 5.2.

Required test equipment

In addition to the DUT and oscilloscope, you need the following:
■ One supported differential probe
■ Four BNC cables (for connecting AFG or AWG5200 to fixture) or two SMA

cables with two BNC to SMA connectors  1

■ GPIB/LAN/USB cable (required if you use AWG automation, connects
AWG and oscilloscope). Refer to Automate AWG/AFG signal generation and 
Instrument configuration using TekVISA.

■ Short automotive cable.

1 Use the Signal Generator for 1000Base-T1 which supports the 125 MHz sine wave differential peak to peak 3.6 volts.
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■ TF-XGbT test fixture

■ TF-BRR-CFD (Clock Frequency Divider Unit): This is used to synchronize
oscilloscope and signal source with the DUT Transmit_CLK.

NOTE. You will need to complete the calibration procedure before doing the
Transmitter Distortion measurement with disturbing signal. The calibration
procedure is used to effectively remove the disturbing signal and compensate for
non-linearity in the disturber and test fixture.

Test setup procedure

The test setup procedure for Transmitter Distortion is divided into two parts as
below:

1. Calibration

2. Measurement Run

Calibration Calibration step is done to calibrate the disturber signal source amplitude and
frequency. It measures the DUT signal level at defined PIN points on the test
fixture. You can perform calibration on live DUT signal and disturber source
signal connected as mentioned in the calibration connection diagram.

Design of the transmitter to tolerate the presence of the remotely driven signal
with acceptable distortion or other changes in performance is a critical issue and
must be addressed by the implementer. A disturbing signal is used to simulate the
presence of a remote transmitter. The disturbing signal is defined as a sine wave
generator that simulates the potential interfering effect of another transmitter.

Automotive Ethernet (1000/100Base T1) measurements that require test mode
4 have to be done with a disturbing signal. Characteristics of disturbing signal are
given in the following table.

The calibration has three parts/steps to calibrate the fixture path:

A. Disturber compensation

B. Test fixture compensation

C. Test fixture compensation without disturber signal
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Figure 61: Calibration tab for 1000Base-T1 transmitter distortion measurement

Figure 62: Calibration tab for 100Base-T1 transmitter distortion measurement
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Figure 63: Disturbing signal compensation with AFG/AWG

NOTE.
■ Ensure that the "+" on the probe tip aligns with  on the text fixture board.

This takes care of the polarity being not reversed.
■ This connection diagram is applicable for the probes whose differential input

dynamic range is less than the amplitude of the disturber signal being
measured.

■ For 100Base-T1, the expected value is <= 5.4/2 Volts, as measured across
the 100 Ω load.
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Figure 64: Disturbing signal compensation with AFG/AWG using TDP3500

NOTE.
■ Ensure that the "+" on the probe tip aligns with  on the text fixture board.

This takes care of the polarity being not reversed.
■ This connection diagram is applicable for the probes whose differential input

dynamic range is less than the amplitude of the disturber signal being
measured.

■ For 100Base-T1, the expected value is <= 5.4/2 Volts, as measured across
the 100 Ω load.

1. Select the Signal Generator source instrument in Global settings.

Follow the Instrument step mention on How to connect the Signal Generator
to oscilloscope.

NOTE. Use the Signal Generator which can generate the (3.6 )⁄2 volte peak-
to-peak for 1000Base-T1.

2. Connect DUT as shown in the above connection diagram.
3. Take two equal length BNC cable.
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4. Connect the 1st BNC Cable to (AFG/AWG) + (J690) and the other end to
Channel 1 of AFG.

5. Connect the 2nd BNC Cable to (AWG/AFG) – (J790) and other end to
Channel 2 of AFG. In case AWG, connect the other end of BNC to
CH1_inverted.

6. Make the jumper shorting settings for the lane selected, respectively.
7. Disconnect the DUT from J700, if DUT is connected.
8. If you are using TDP3500 probe (100Base-T1 Tx-Distortion), connect the

Load Calibration unit to J700 Port using short RJ45 cable.
9. From the Measurement Configuration tab > Select Calibration tab > Under

step 1 of 3 (Disturber Compensation), click RUN button.

The application will automatically configure the selected Signal Generator to
the specified frequency and its amplitude level as defined in the specification.

NOTE.
■ For 100Base-T1, set the attenuator factor to 10X on the probe if you are

using P6247\6248.
■ Ensure that the "+" on the probe tip aligns with ► on the text fixture board.

This takes care of the polarity being not reversed.
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Test fixture compensation

Figure 65: Disturbing signal compensation with AFG/AWG

NOTE.
■ When using high input impedance differential probe, ensure that each of the

single ended lanes is terminated with 50 Ω.
■ Ensure that the "+" on the probe tip aligns with  on the text fixture board.

This takes care of the polarity being not reversed.

1. Connect the DUT to RJ45 of TC1, J5 port.
2. Turn on DUT and set the DUT to run Test Mode 4 signal.
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3. Connect the Differential probe tip to P12 pin.

NOTE. Indicate the positive probe tip to be connected on test fixture. As per
your DUT single twisted pair output, you can get the signal from one of the
P2, P6, or P9 pin.

4. Close J11 and J13 with the 50 Ω terminator cap, which is with respect to P12
pin.

5. From the Measurement Configuration tab > Select Calibration tab > Under
step 2 of 3 (Test Fixture Compensation), click RUN button and wait to
display the measured value in the table.

NOTE.
If the expected and the measured values do not match using the AWG/AFG
automation, follow the steps below:

1. Load the setup file manually on the AWG/AFG.
2. In Global Settings for the measurement, set the Signal Generator to 'Do not

use'.
3. Run the calibration.
4. Make changes to frequency/amplitude on the Signal Generator to match the

expected values.
5. Repeat the steps 3 and 4, until the measured and the expected values closely

match.
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Figure 66: Disturbing Signal Compensation with AFG/AWG

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

1. Connect the DUT as shown in the connection above diagram.
2. Make the jumper shorting settings for the lane selected, respectively.
3. Disconnect the BNC cable J790 and J690, if it is connected.

Automotive Ethernet measurements  

120  TekExpress Automotive Ethernet



4. From the Measurement Configuration tab > Select Calibration tab > Under
step 3 of 3 (Test Fixture Compensation), click RUN button.

The Automotive Ethernet Software Solution will automatically configure the
selected Signal Generator to the specified frequency and its amplitude level
as defined in the specification.

NOTE. Ensure "+" on the probe tip aligns with ► on the text fixture board.
This takes care of the polarity being not reversed.

100Base-T1 AFG Configuration The AFG setup happens automatically when
you click the Run button at Step-1 of Disturber Compensation on Calibration tab.

Use the following steps for AFG:

1. Set amplitude to 5.4 Vpp.
2. Set frequency to 11.111 MHz.
3. Set the external Ref clock.
4. Turn on CH1 and CH2.

Point 1, 2, and 3 are applicable for both CH1 and CH2 and the phase set to CH1
is 0 degrees and for CH2, it is 180 degrees. For more details, refer to connection
diagram (Test Fixture Compensation (2 of part 3) and Measuring amplitude with
disturbing signal OFF and DUT signal ON (3 of part 3)).

NOTE.
■ Ensure that before clicking the Start button the calibration steps are

performed.
■ During calibration, the signal source AFG/AWG will be setup automatically

from the application by loading the disturber pattern.
■ When you click the Start button, the AFG/AWG does not setup, only

oscilloscope will setup because the application will not disturb the
calibration done using AFG/AWG.

1000Base-T1 AFG Configuration

The AFG/AWG setup happens automatically when you click the Run button at
Step-1 of Disturber Compensation on Calibration tab.

Use the following steps for AFG:

1. Set amplitude to 3.6 Vpp.
2. Set frequency to 125 MHz.
3. Set the external Ref clock.
4. Turn on CH1 and CH2.
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Point 1, 2, and 3 are applicable for both CH1 and CH2 and the phase set to CH1
is 0 degrees and for CH2, it is 180 degrees. For more details, refer to connection
diagram (Test Fixture Compensation (2 of part 3) and Measuring amplitude with
disturbing signal OFF and DUT signal ON (3 of part 3)).

NOTE.
■ Ensure that before clicking the Start button the calibration steps are

performed.
■ During calibration, the signal source AFG/AWG will be setup automatically

from the application by loading the disturber pattern.
■ When you click the Start button, the AFG/AWG does not setup, only

oscilloscope will setup because the application will not disturb the
calibration done using AFG/AWG.

The application automatically controls the AWG 5202 for 1000Base-T1 and
AWG 5K/AWG 7K for 100Base-T1 similarly to that of the AFG configuration.
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Measurement: Software
signal correction or None

method for 1000/100Base-
T1

Figure 67: Connection diagram for Software Signal Correction or None method-AWG

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.
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Make the connection as above:

1. Click Apply after completing the calibration.
2. Click Measurement tab, and then select one of the options from the

Configuration tab.
3. Ensure that the Jumper and the Probe setting as mention in Step 1 of

3 ( Refer A. Disturber Signal setup (1 of part 3) (AWG) section). Refer 
Calibration on page 113.

4. Select the Software Signal Correction or None method.

The Software Signal Correction is selected by default and available for
100Base-T1.

5. Make the connection setup without the clock divider.

For the Software Signal Correction option, the measurement corrects the
acquired signal and adjusts the phase like a hardware clock divider unit, and
then performs the peak distortion

When None option is selected, the Tx distortion measurement is performed
without hardware CDU operation or software signal correction method.

Hardware clock divider
method for 1000/100Base-

T1

1. Click Apply after completing the calibration.
2. Click Measurement tab, and then select one of the options from the

Configuration tab.
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a. Hardware Clock Divider option
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Figure 68: Hardware clock divider

NOTE. Ensure that the "+" on the probe tip aligns with  on the text
fixture board. This takes care of the polarity being not reversed.

■ Select Hardware Clock Divider.
■ As highlighted in the figure of the Hardware Clock Divider (TF-

BRR-CFD) unit the toggle switch B8 should be in:

■ 100 Base-T1: toggle down position for the PLL to lock with
66.666 MHz of transmit clock frequency signal.
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■ 1000 Base-T1: toggle up position for the PLL to lock with
125 MHz of transmit clock frequency signal.

■ Make the connection setup with the clock divider as show above. The
clock divider synchronizes the oscilloscope and the disturber source.

NOTE.
■ In case the automation with AFG/AWG is selected in the Global

setting tab, the disturber pattern is automatically loaded during
the disturber compensation process.

■ In case of an unstable 10 MHz clock output from the Clock
Divider Unit, restart the Clock Divider unit.

■ Check the amplitude of the 10 MHz clock coming from Clock
Divider Unit; it should not exceed the limit mentioned on the
oscilloscope and AFG/AFG for 10 MHz reference input signal.

■ If the External Reference Clock signal is stable (10 MHz), the
oscilloscope will phase-lock with the external reference clock.
This can be seen in the following image as "XRef", which
indicates acquired signal is properly locked. The oscilloscope
displays "NoRef", in case of unlocked phase. It indicates that the
External Reference Clock is not proper and can result in
incorrect results.

Figure 69: XRef
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Item Requirements
Signal type Test mode 4 for 100Base-T1

 

 
Test mode 4 for 1000Base-T1
 

 
Measurement algorithm outputs All the computed 10 peaks must be less than

15 mV.
Measurement algorithm inputs Test mode 4 signal captured in differential form

Disturbing Signal. Lower limit is NA. Upper limit
is 15 mV.

See also Plots
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Return loss measurement
This measurement confirms that the return loss of the DUT is within
conformance limits. You can perform return loss measurement by oscilloscope
method or VNA report method (S-parameter file s1p/s2p).

Suite Description
1000Base-T1 Physical Layer Specifications (IEEE Std 802.3bp™-2016) a parameter for

1 Gb/s Operation over a Single Twisted-Pair Copper Cable section
97.7.2.1 MDI Return Loss not Transmitter Clock Frequency test.

100Base-T1 BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 96.8.2.1 
BroadR-Reach Physical Media Attachment Test Suite version 2.0,
section 5.6.

Steps to perform return
loss measurement by
oscilloscope method

Required test equipment

In addition to the DUT and oscilloscope, you need the following:

■ Two supported differential probes
■ Three BNC cables (for connecting AFG or AWG to fixture) or three SMA

cables with two BNC to SMA connectors (for connecting AWG7K to fixture)
and TCA-BNC or TCA-SMA adapters (auxiliary)

■ AWG with bandwidth >= 600 MHz and high AC voltage option (for
1000Base-T1)

■ Short RJ45 connector and short automotive cable.
■ GPIB/LAN/USB cable to connect the oscilloscope to AWG and automate

signal generation. Refer to Automate AWG/AFG signal generation and 
Instrument configuration using TekVISA.

■ TF-XGbT test fixture and fixture with loads (Open, Short, and Load)
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Test name Requirements
Signal type 100Base-T1

 

 
1000Base-T1
 

 

Test setup procedure

Return Loss measurement has two steps to run the test:

1. Fixture calibration using Open, Load, and Short circuit
2. Perform the return loss test

Steps to perform fixture calibration using Open, Load, and Short circuit
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Figure 70: Fixture calibration using Open, Load, and Short circuit

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

1. Connect the equipment as shown in the connection diagram.
2. Open the Instrument Control settings from the Option menu.
3. Select the options from the Search Criteria and click Refresh button.

Wait for the signal source to display in list. If you are using LAN connect,
follow the LAN configuration steps before doing these steps.

 Automotive Ethernet measurements

TekExpress Automotive Ethernet 131



4. Click the Global Settings tab on the Test selection panel to view the listed
instruments.

5. Click Calibration tab and then press the RUN button corresponding to
Open / Load / Short calibration; then the selected AWG instrument
automatically load with calibration pattern.

NOTE.
If TF-XGbT is being used, ensure that Channel 1 is connected to P23 of TC3 and
Channel 2 to P24 of TC3. Do not reverse Channel 1 to P2 and Channel 2 to P1;
this will affect the machine.

If TF-GBE-BTP is being used, ensure that Channel 1 is connected to P1 of TC1
and Channel 2 to P2 of TC1. Do not reverse Channel 1 to P2 and Channel 2 to
P1; this will affect the machine.

When you perform Return Loss measurement in 1000BASE-T1 suite, the
recommended signal source is AWG5200. Make sure the CH1(+) of AWG is
connected to J26(+), CH1(-) of AWG is connected to J21(-) and marker 1:1 is
connected to the AUX channel of the oscilloscope.
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Steps to perform the return loss test after calibration

Figure 71: Connection diagram for Return Loss test with AFG/AWG

NOTE. Ensure that the "+" on the probe tip aligns with  on the text fixture
board. This takes care of the polarity being not reversed.

1. After the completion of the Load, Open, and Short calibration in LIVE mode,
click the Apply button in the Calibration tab. If the Calibration is Run with
just near time, use the Use Pre-Recorded Files and select the File path and
click Apply.

2. Connect the DUT setup as shown in above figure.
3. Configure the DUT for SLAVE IDLE mode of operation.
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4. Connect the DUT with one end of 4-inch Automotive Ethernet cable and
another end to RJ45 J20 of TC3. Connection for the AWG is as show in
below images

5. Click the Start button to measure the reflections at the MDI referenced to a
100Ω characteristic impedance.

The measurement will Run and navigate to the Results panel.

Figure 72: Pre-recorded calibration file

Figure 73: Live Calibration
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Table 27: Limits

Lower limit Upper limit
100Base-T1 NA  

 
 

 
1000Base-T1 NA  
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Steps to perform return
loss measurement by VNA

Report

1. Select Setup > DUT.
2. In the DUT tab:

a. Select Return Loss Measurement preferences as VNA Report.
b. Select View as Advanced.

3. Select Configuration > Global Settings.
4. Click Browse and select the VNA Result file.
5. Click Start to run the measurement.
6. Select Results panel to view the measurement statistics and Pass/Fail status.
7. After the test execution is complete, the detailed report is displayed.

 

 

See also Plots
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SCPI Commands

About SCPI command
You can use Standard Commands for Programmable Instruments (SCPI) to
communicate with the TekExpress application.

Socket configuration for SCPI commands
This section describes the steps for TCPIP socket configuration and TekVISA
configuration to execute the SCPI commands.

TCPIP socket
configuration

1. Click Start > Control Panel > System and Security > Windows Firewall >
Advanced settings.
 

 

TekExpress Automotive Ethernet 137



2. In Windows Firewall with Advanced Security menu, select Windows
Firewall with Advanced Security on Local Computer > Inbound Rules
and click New Rule…
 

 
3. In New Inbound Rule Wizard menu

a. Select Port and click Next.
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b. Select TCP as rule apply and enter 5000 for Specific local ports and
click Next.
 

 
c. Select Allow the connection and click Next.
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d. Select Domain, Private, Public and click Next.
 

 
e. Enter Name, Description (optional), and click Finish.
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4. Check whether the Rule name is displayed in Windows Firewall with
Advanced Security menu > Inbound Rules.
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TekVISA configuration 1. Click Start > All Programs > TekVISA > OpenChoice Instrument
Manager.
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2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on.
Select Socket from the drop-down list, enter the IP address of the

TekExpress device in Hostname and type Port as 5000. Click  to
configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application
are in the same system, else enter the IP address of the TekExpress
application system.
 

 

 SCPI Commands

TekExpress Automotive Ethernet 143



3. Click Search to setup the TCPIP connection with the host. Check whether
the TCPIP host name is displayed in OpenChoice Instrument Manager >
Instruments.
 

 
4. Double-click OpenChoice Talker Listener and enter the Command *IDN?

in command entry field and click Query. Check that the Operation is
successful and Talker Listener Readout displays the Command / Data.
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TEKEXP:*IDN?
This command queries the active TekExpress application name running on the
oscilloscope. 

Syntax TEKEXP:*IDN?\n

Inputs NA

Outputs Returns active TekExpress application name running on the oscilloscope.

TEKEXP:*OPC?
This command queries the execution status of the last executed command. 

Syntax TEKEXP:*OPC?\n

Inputs NA

Outputs 0 - last command execution is not complete

1 - last command execution is complete
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TEKEXP:ACQUIRE_MODE
This command sets the acquire mode as live or pre-recorded.

Syntax TEKEXP:ACQUIRE_MODE {LIVE | PRE-RECORDED}\n

Inputs {LIVE | PRE-RECORDED}

Outputs NA

TEKEXP:ACQUIRE_MODE?
This command queries the acquire mode type.

Syntax TEKEXP:ACQUIRE_MODE?\n

Inputs NA

Outputs {LIVE | PRE-RECORDED}
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TEKEXP:EXPORT
This command returns all the bytes of data to the specified file. 

Syntax Outputs
TEKEXP:EXPORT REPORT\n Returns the report file in bytes
TEKEXP:EXPORT WFM,"<FileName>"\n Returns the specified waveform file in bytes
TEKEXP:EXPORT IMAGE,"<FileName>"\n Returns the specified image file in bytes

Inputs FileName - Specifies the file name

TEKEXP:INFO?
This command queries the information about the file(s).

Syntax Outputs
TEKEXP:INFO?
REPORT\n

<ReportFileSize>,"<ReportFileName.mht>"

TEKEXP:INFO? WFM
\n

<WfmFile1Size>,"<WfmFileName1.wfm>";<WfmFile2Size>,"<WfmFileNa
me2.wfm>";...

TEKEXP:INFO?
IMAGE\n

<Image1FileSize>,"<Image1FileName>";<Image2FileSize>,"<Image2File
Name>" ;...
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TEKEXP:INSTRUMENT
This command sets the value for the selected instrument type. 

Syntax TEKEXP:INSTRUMENT "<InstrumentType>",<Value>"\n

Inputs InstrumentType

Value

TIP. Check Command parameters list section for InstrumentType and Value
parameters.

Outputs NA

TEKEXP:INSTRUMENT?
This command queries the instrument selected for the specified instrument type. 

Syntax TEKEXP:INSTRUMENT? "<InstrumentType>"\n

Inputs InstrumentType

TIP. Check Command parameters list section for InstrumentType parameters.

Outputs Returns the instrument selected for the specified instrument type
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TEKEXP:LASTERROR?
This command queries the last error string occurred for the current TCP session.
If there are no errors since startup, or since the last call to
TEKEXP:LASTERROR?\n, this command returns an empty string.

Syntax TEKEXP:LASTERROR?\n

Inputs NA

Outputs <string>

TEKEXP:LIST?
This command queries the list of available device, suite, test, version or
instrument. 

Syntax Outputs
TEKEXP:LIST? DEVICE\n Returns the list of available device(s) as comma

separated values.
TEKEXP:LIST? SUITE\n Returns the list of available suite(s) as comma

separated values.
TEKEXP:LIST? TEST\n Returns the list of available test(s) as comma

separated values.
TEKEXP:LIST? VERSION\n Returns the list of available version(s) as comma

separated values.
TEKEXP:LIST?
INSTRUMENT,"<InstrumentType>"\n

Returns the list of available instruments' for the
given Instrument type as comma separated
values.

NOTE. This command returns the list of items within double quotes (""). Iterate
the receive procedure until the list ends with double quotes otherwise the next
query commands won’t work as expected.
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Inputs InstrumentType

TIP. Check Command parameters list section for InstrumentType parameters.

TEKEXP:MODE
This command sets the execution mode as compliance or user defined. 

Syntax TEKEXP:MODE {COMPLIANCE | USER-DEFINED}\n

Inputs {COMPLIANCE | USER-DEFINED}

Outputs NA

TEKEXP:MODE?
This command queries the execution mode type. 

Syntax TEKEXP:MODE?\n

Inputs NA

Outputs {COMPLIANCE | USER-DEFINED}
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TEKEXP:POPUP
This command sets the response to the active popup shown in the application.

Syntax TEKEXP:POPUP “<PopupResponse>”\n

Inputs PopupResponse

Outputs NA

TEKEXP:POPUP?
This command queries the active popup information shown in the application.

Syntax TEKEXP:POPUP?\n

Inputs NA

Outputs Returns the active popup information in the application.
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TEKEXP:REPORT
This command generates the report for the current session. 

Syntax TEKEXP:REPORT GENERATE\n

Inputs GENERATE

Outputs NA

TEKEXP:REPORT?
This command queries the queried header field value in the report.

Syntax TEKEXP:REPORT? “<HeaderField>”\n

Inputs HeaderField - Specifies to return the measured value for the indicated test.

TIP. Check Report for HeaderField parameters.

Outputs Returns the queried header field value in the report
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TEKEXP:RESULT?
This command queries the result available in report summary/details table.

Syntax Outputs
TEKEXP:RESULT? "<TestName>"\n Return Pass/Fail status of the test.
TEKEXP:RESULT?
"<TestName>","<ColumnName>"\n

Returns all the row values of the specified
column for the test.

TEKEXP:RESULT?
"<TestName>","<ColumnName>",<RowNumber
>\n

Returns the column value for the specified row
number  1

Inputs TestName - Specifies the name of the test for which to obtain the test result
value.

ColumnName - Specifies the column name for the measurement

RowNumber - Specifies the row number of the measurement

TIP. Check Results panel for TestName, ColumnName, and RowNumber
parameters.

1 Row number starts from zero.

 SCPI Commands

TekExpress Automotive Ethernet 153



TEKEXP:SELECT
This command selects the device, suite, version, or test. 

Syntax TEKEXP:SELECT <string1>,<string2>,<string4>\n

TEKEXP:SELECT TEST,<string3>,<string4>\n

Inputs <string1> = {DEVICE | SUITE | VERSION}

<string2> = {DeviceName | SuiteName | VersionName}

<string3> = {“<TestName>"| ALL| REQUIRED }

<string4> = {TRUE | FALSE}

TIP. Check Command parameters list section for DeviceName, SuiteName,
VersionName, and TestName parameters.

Outputs NA

TEKEXP:SELECT?
This command queries the name of the selected device, suite, version, or test. 

Syntax TEKEXP:SELECT? {DEVICE | SUITE | TEST | VERSION}\n

Inputs {DEVICE | SUITE | TEST | VERSION}
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Outputs Returns the name of the selected device, suite, version, or test.

TEKEXP:SETUP
This command sets the value of the current setup.

Syntax Outputs
TEKEXP:SETUP DEFAULT\n Restore to default Setup
TEKEXP:SETUP OPEN,"<SessionName>"\n Open the session
TEKEXP:SETUP SAVE\n Saves the already existing modified session
TEKEXP:SETUP SAVE,"<SessionName>"\n Save the session

Inputs SessionName - The name of the session

TEKEXP:STATE
This command sets the execution state of the application.

Syntax TEKEXP:STATE {RUN | STOP | PAUSE | RESUME}\n

Inputs {RUN | STOP | PAUSE | RESUME}

Outputs NA
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TEKEXP:STATE?
This command queries the current setup state. 

Syntax Outputs
TEKEXP:STATE? RUNNING | PAUSED | WAIT | ERROR | READY
TEKEXP:STATE? SETUP SAVED | NOT_SAVED

TEKEXP:VALUE
This command sets the value of parameters of type General, Acquire, Analyze, or
DUTID. 

Syntax TEKEXP:VALUE GENERAL,"<ParameterName>",“<Value>”\n

TEKEXP:VALUE ACQUIRE,“<TestName>","<AcquireType>",
"<ParameterName>",“<Value>”\n

TEKEXP:VALUE ANALYZE,“<TestName>","<ParameterName>".“<Value>”
\n

TEKEXP:VALUE DUTID,“<Value>”\n

TEKEXP:VALUE VERBOSE,{TRUE | FALSE}\n

TEKEXP:VALUE
WFMFILE,<Test_Name>,<Aquire_Type>,<FilesName1$FileName2>\n

Inputs ParameterName - Specifies the parameter name

TestName - Specifies the test name

AcquireType - Specifies the acquire type

Value - Specifes the value to set

FilesName1$FileName2 - Specifies the waveform file name

TRUE - Pop-ups are enabled

FALSE - Pop-ups are disabled

TIP. Check Command parameters list section for ParameterName, AcquireType,
and Value parameters.
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Outputs NA

TEKEXP:VALUE?
This command queries the value of the parameter for type General, Acquire,
Analyze, or DUTID.

Syntax Outputs
TEKEXP:VALUE?
GENERAL,"<ParameterName>"\n

Returns the value of Parameter for type
GENERAL

TEKEXP:VALUE? ACQUIRE,“<TestName>",
"<AcquireType>","<ParameterName>"\n

Returns the value of Parameter for type
ACQUIRE

TEKEXP:VALUE? ANALYZE,
“<TestName>","<ParameterName>"\n

Returns the value of Parameter for type
ANALYZE

TEKEXP:VALUE? DUTID\n Returns the DUTID value
TEKEXP:VALUE?
WFMFILE,<Test_Name>,<Aquire_Type>\n

Returns the waveform file name

TEKEXP:VALUE? VERBOSE Returns the verbose mode type

Inputs ParameterName - Specifies the parameter name

TestName - Specifies the test name

AcquireType - Specifies the acquire type

TRUE - Pop-ups are enabled

FALSE - Pop-ups are disabled

TIP. Check Command parameters list section for ParameterName and
AcquireType parameters.

Outputs Returns the value of Parameter for type GENERAL | ACQUIRE | ANALYZE |
DUTID.
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Command parameters
This section provides the parameters list for the SCPI commands.

ParameterName and Value for DUT, Test selection, Acquisition,
Configuration and Preferences tabs

Specifies the ParameterName and Value for DUT, Test selection, Acquisition,
Configuration and Preferences tabs

Table 28: ParameterName and Value for DUT tab

Parameters Description
DUT ID Specifies the value parameters.

■ For DUTID, valid value is:

■ Comment

Acquiremode Specifies the acquire mode parameters

■ Acquire live waveforms
■ Use pre-recorded waveform files.

Suite Sets the suite.

■ 100Base-T1
■ 1000Base-T1

Table 29: ParameterName and Value for Test selection tab

Parameters Description
TestName Specifies the test measurement name.

Valid values are:

■ Transmit Clock Frequency
■ Transmitter Timing Jitter-Master Jitter
■ Transmitter Timing Jitter-Slave Jitter
■ Transmitter Output Droop
■ Transmitter Power Spectral Density
■ Transmitter Distortion
■ Return Loss
■ Return Loss Calibration
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Table 30: ParameterName and Value for Acquisitions tab

Parameters Description
Probe1, Probe 2 Specifies the probe source channel for each listed signal.

Valid values are:

■ CH1
■ CH2
■ CH3
■ CH4

Show Acquire Parameters TRUE or FALSE
Acquire Step By Step TRUE or FALSE
Signal Validation ■ Prompt me if signal fails

■ Use signal as it is-Don't check
■ Skip test if signal fails

Table 31: ParameterName and Value for Preferences tab

Parameters Description
On Test Failure, stop and notify
me of the failure

TRUE or FALSE

ParameterName and Value for General, Acquire and Analyze

Specifies the ParameterName and Value for General, Acquire and Analyze. The
configuration parameters available are not same for measurements.

Table 32: ParameterName and Value for General

ParameterName Value
Report Update Mode ■ New

■ Append
■ Replace

Report Creating Settings
Report name X:\BRR\Reports\DUT001.mht
Save As Type ■ Web Archive (*.mht;*.mhtml)

■ PDF (*.pdf;)

Auto increment report name if
duplicate

TRUE or FALSE

Create report at the end ■ Included
■ Excluded
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ParameterName Value
Upload logo Need info
Contents to Save
Include Pass/Fail Results
Summary

TRUE or FALSE

Include Detailed Results TRUE or FALSE
Include Plot Images TRUE or FALSE
Include Setup Configuration TRUE or FALSE
Include Complete Application
Configuration

TRUE or FALSE

Include User Comments TRUE or FALSE

Table 33: ParameterName and Value for Acquire

Test Name ParameterName AcquireType Value
Transmit Clock
Frequency

Record Length 1 to 20 

TransmitterTiming
Jitter-Master Jitter

Record Length 1 to 20 

Transmittter Timing
Jitter-Slave Jitter

Record Length 1 to 20 

Transmitter Output
Droop

Averages 2 to 100 

Transmitter Power
Spectral Density

Averages 2 to 256 

Transmitter Distortion No Configuration Available NA
Return Loss Averages 2 to 512 

Table 34: ParameterName and Value for Analyze

Test Name ParameterName AcquireType Value
Transmit Clock
Frequency

NA NA

TransmitterTiming
Jitter-Master Jitter

Edge

■ Falling
■ Rising

NA

Hysteresis Need info
Transmittter Timing
Jitter-Slave Jitter

Edge

■ Falling
■ Rising

Need info

Hysteresis Need info
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Test Name ParameterName AcquireType Value
Transmitter Output
Droop

NA NA

Transmitter Power
Spectral Density

RBW 1 to 100 
Center Frequency 1 to 500 
Frequency Span 1 to 500 

Transmitter Distortion No Configuration Available NA
Return Loss Smooth 0 to 10 

Examples
This section provides the examples for the SCPI commands.

Example Description
TEKEXP:*IDN? It returns the active TekExpress application name running on the

scope.
TEKEXP:*OPC? It returns the last command execution status.
TEKEXP:ACQUIRE_MODE PRE-RECORDED It sets the acquire mode as pre-recorded.
TEKEXP:ACQUIRE_MODE? It returns LIVE when acquire mode is set to live.
TEKEXP:EXPORT REPORT It returns the report file in bytes. This can be written into another file

for further analysis.
TEKEXP:INFO? REPORT It returns "100,"ReportFileName.mht"", when 100 is the filesize in

bytes for the filename ReportFileName.
TEKEXP:INFO? WFM It returns "100,"WfmFileName1.wfm"";"200,"WfmFileName2.wfm""

when 100 is the filesize in bytes for the filename
WfmFileName1.wfm and 200 is the filesize in bytes for the filename
WfmFileName2.wfm.

TEKEXP:INSTRUMENT "Real Time Scope",MSO58
(GPIB8::1::INSTR)

It sets the instrument value as MSO58 ( GPIB8::1::INSTR ) for the
selected instrument type Real Time Scope.

TEKEXP:INSTRUMENT? "Real Time Scope" It returns "MSO58 ( GPIB8::1::INSTR ), when MSO58
( GPIB8::1::INSTR )" is the selected instrument for the instrument
type Real Time Scope.

TEKEXP:LASTERROR? It returns ERROR: INSTRUMENT_NOT_FOUND, when no
instrument is found.

TEKEXP:LIST? INSTRUMENT,"Real Time Scope" It returns "MSO58 ( GPIB8::1::INSTR ),MSO64 ( TCPIP::
134.64.248.91::INSTR )" when MSO58 ( GPIB8::1::INSTR ), MSO64
( TCPIP::134.64.248.91::INSTR ) are the list of available
instruments.

TEKEXP:MODE COMPLIANCE It sets the execution mode as compliance.
TEKEXP:MODE? It returns COMPLIANCE when the execution mode is compliance.
TEKEXP:POPUP "OK" It sets OK as the response to active popup in the application.
TEKEXP:POPUP? It returns "OK", when OK is the active popup information shown in

the application.
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Example Description
TEKEXP:REPORT GENERATE It generates report for the current session.
TEKEXP:REPORT? "Scope Model" It returns "MSO58" when MSO58 is the scope model.
TEKEXP:REPORT? "DUT ID" It returns "DUT001" when DNI_DUT001 is the DUT ID.
TEKEXP:RESULT? "PeakVoltageD_Without_Disturber" It returns Pass, then the test result is Pass.
TEKEXP:RESULT? "PeakVoltageD_Without_Disturber", "Margin" It returns list of values then that is 'Margin' column data.
TEKEXP:RESULT? "PeakVoltageD_Without_Disturber", "Units",0 It returns the unit of the first row of result.
TEKEXP:SELECT TEST,"Transmitter Output Droop", TRUE It selects "Transmitter Output Droop" measurement.
TEKEXP:SETUP DEFAULT It restores the application to default setup.
TEKEXP:VALUE WFMFILE,"Transmitter Output Droop","Transmitter
Output Droop Acquisition","C:\AutoEthernet_SCPI_TestSuite
\RefWaveforms\100Base-
T1\Transmitter_Output_Droop_TestMode1.wfm

It assigns the pre recorded waveform to the Droop measurement.

TEKEXP:VALUE? WFMFILE,,"Transmitter Output
Droop","Transmitter Output Droop Acquisition"

It queries the pre recorded assigned waveform.

TEKEXP:VALUE GENERAL,"ReturnLoss Measurement
Method","VNA Report"

It sets the return loss measurement preferences as VNA Report.

TEKEXP:VALUE? GENERAL,"ReturnLoss Measurement Method" It returns the selection of return loss measurement preferences.
TEKEXP:VALUE GENERAL,"VNA Report File Path","C:\Users
\Public\Tektronix\TekApplications\Automotive-Ethernet
\ExampleSparamFiles\Example.s2p"

It sets VNA Result File to C:\Users\Public\Tektronix\TekApplications
\Automotive-Ethernet\ExampleSparamFiles\Example.s2p.

TEKEXP:VALUE? GENERAL,"VNA Report File Path" It returns the VNA result file path.
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Measurement error messages
The following table lists all of the error messages associated with TekExpress
Automotive Ethernet measurements and their definitions.

Table 35: Measurement error messages

Error message Description
Transmitter Output Droop measurement (Test mode 1)
Signal Validation failed for test mode 1. Make sure that
input signal has:

■ Edge to Edge period deviation is less than 10%
■ At least 2 Unit Intervals

This error occurs if the input signal
does not meet the requirements given
in specification for test mode 1 signal.
Edge to Edge period 33 unit intervals
(500 ns)

Signal validation failed for test mode 1.Make sure that
input signal has:

■ Rise to Rise period deviation is less than 10%.

This error occurs if the input signal
has Rise to Rise period deviation of
more than 10%. Rise to Rise period
value (500 ns)

Signal validation failed for test mode 1.Make sure that
input signal has:

■ Fall to Fall period deviation is less than 10%.

This error occurs if the input signal
has Fall to Fall period deviation of
more than 10%. Fall to Fall edge
period value (500 ns)

Signal validation failed for test mode 1.Make sure that
input signal has:

■ Edge to Edge period is greater than 500 nano
seconds

This error occurs if the input signal
does not meet the Edge to Edge
period greater than 500 nano
seconds.

Transmitter Clock Frequency measurement and Transmitter Timing Master Jitter
measurements (Test mode 2)
Signal Validation failed for test mode 2. Make sure that:

■ For 100Base-T1: The unit interval/frequency of the
signal does not deviate beyond ± 100 ppm from
66(2/3) MHz.

■ For 1000Base-T1: The unit interval/frequency of the
signal does not deviate beyond ± 100 ppm from
125 MHz.

For 100Base-T1: This error occurs if
the input frequency of the acquired
test mode 2 signal is varies beyond
66(2/3) MHz ± 100 ppm.
For 1000Base-T1: This error occurs if
the input frequency of the acquired
test mode 2 signal is varies beyond
125 MHz ± 100 ppm.

Signal Validation failed for test mode 2. Ensure that input
signal has:

■ Rise to Rise period deviation is less than 10%.

This error occurs if the input signal
has Rise to Rise period deviation of
more than 10%.
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Error message Description
Signal Validation failed for test mode 2. Ensure that input
signal has:

■ Fall to Fall period deviation is less than 10%.

This error occurs if the input signal
has Fall to Fall period deviation of
more than 10%.

Signal validation failed for test mode 2.Make sure that
input signal has:

■ For 100Base-T1: Edge to Edge period deviation is
less than 10% compared to 66(2/3) MHz Tx_Clk.

For 1000Base-T1: Edge to Edge period deviation is
less than 10% compared to 125 MHz Tx_Clk.

■ At least 2 Unit Intervals,
■ Input is not clock signal (test mode 2).

This error occurs if the input signal
has:

■ For 100Base-T1: Edge to Edge
period deviation is more than
10% compared to 66(2/3) MHz
Tx_Clk.

For 1000Base-T1: Edge to Edge
period deviation is more than
10% compared to 125 MHz
Tx_Clk.

■ More than two cycles are need to
execute the measurement.

■ Input signal is not a clock signal
(test mode 2).

Transmitter Timing Slave Jitter Measurement (Test mode 3)
Signal validation failed for TX_TCLK signal. Make sure
that:

■ The Edge to Edge deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Signal validation failed for TX_TCLK signal. Make sure
that input signal has:

■ Rise to Rise period deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Signal validation failed for TX_TCLK signal. Make sure
that input signal has:

■ Fall to Fall period deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Transmitter Distortion and Return Loss Measurement (Test mode 4)
Signal Validation failed for test mode 4. Ensure that input
signal:

■ Is PAM3 modulated
■ Has at least 3 frames of test mode 4 (2047 bits).
■ The common possible cause could be polarity of the

probing points being reversed. Ensure Probe tip '+'
aligns with '<' on the test fixture board.

This error will occur if the input signal
does not meet the requirements given
in specification for test mode 4 signal.
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Error message Description
Signal Validation failed for test mode 4. Ensure that:

■ For 100Base-T1: Interval/frequency of the Clock
signal does not deviate beyond ± 100 ppm from
66(2/3) MHz.

For 1000Base-T1: Interval/frequency of the Clock
signal does not deviate beyond ± 100 ppm from
125 MHz.

This error occurs if the input signal
does not meet the requirements given
in specification for test mode 4 signal.
Follow the instruction and step 3. For
more information, see Table 20:
Measurement setup and algorithm.

Return Loss and Power Spectral Density Measurement (Test mode 5)
Calibration files are not present for return loss
measurement. Either Deselect the Measurement or Stop
the Execution, Perform Calibration and Re-Run the test.

This error occurs if return loss
measurement is executed without
calibration files. Always run the
calibration and then execute return
loss measurement. If calibration is
done, return loss measurement uses
latest available calibration files.

Return Loss Measurement (Test mode is Slave Idle)
S parameter file is not present for Return Loss
measurement. Please select a file and re-run.
 

 

This error occurs if the VNA Result file
is not selected in Configuration >
Global Settings.

Unable to run VNA based Return Loss measurement. The
S11 data in the file provided is either invalid/zeros. Select
a valid 's' parameter file and rerun test.
 

 

The S11 data in the VNA result file
selected for the Return Loss
measurement is either invalid or zero.
Select a VNA result file with valid 's'
parameter and re-run the test.

Error message applicable to all tests
Not Enough Edges in the Waveform. Acquire the
waveform for a longer duration.

This error occurs If the input signal
does not have enough rise to fall and
fall to rise transitions.

Data points acquired is insufficient for moving average
filtering. Set the start frequency, stop frequency and RBW
such that (stop frequency - start frequency)/RBW is
greater than 3.

User should check the start frequency,
stop frequency and RBW setting. This
error will occur If the waveform does
not have enough frequencies between
the start and stop frequency.
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Error message Description
Captured Signal has less than 3 segments, Please
increase Record Length.

This error occurs If the input signal
has less than three segments of test
mode 4 signal (2047 bits).

Unable to run because return loss measurement is not
calibrated. Calibrate and apply the return loss
measurement, and then click on start.

This error occurs if user tries to
execute return loss measurement
without applying calibration
(computation of error coefficients).

Invalid Signal at CH1. Please check DUT connections and
re-run the test.

This error occurs if an invalid signal is
fed as input to return loss
measurement (wrong connection).

Signal validation failed for Test Mode.Input waveform is
not found.

This error occurs when waveform is
not found for signal validation.

Measurement algorithms

Return loss Calibration

The calibration procedure is required to correct for probe and fixture loading in
the final measured result. Calibration is done using three loads: open, short, and
100 Ω load.

TekExpress Automotive Ethernet Compliance Solution executes the calculations
described below for the return loss calibration:

1. Multiply the acquired signals using Gaussian window (convolving in
frequency domain) and then compute the reflected and incident voltages.

Reflected voltage = (2*P1 – P2)

Incident voltage = P1

2. Return loss is computed as follows:

Return loss = FFT(Reflected voltage)/ FFT(Incident voltage)

This return loss is computed for three types of loads: Open, Short, 100 Ω
load. Let the return loss computed be Gamma_Open, Gamma_Short, and
Gamma_Load for open, short, and 100 Ω load, respectively. The
Gamma_Open, Gamma_Short,and Gamma_Load are dumped in csv files.

3. For plotting purpose, Gamma_Open, Gamma_Short, and Gamma_Load are
converted to dB scale, interpolated, and smoothed. Interpolated and
smoothed Gamma_Open, Gamma_Short, and Gamma_Load are plotted for
visual representation.

Computing error coefficients
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Automotive Ethernet Automated Compliance Solution executes the calculations
described below for the return loss error coefficient calculation.

1. Gamma_Open, Gamma_Short, and Gamma_Load are used for computing the
following three coefficient that are required for computing cable return loss:

a. b – Gamma_Short + c * Gamma_Short

b. Gamma_Load

c. (Gamma_Short + Gamma_Open – 2 * b) / (Gamma_Short –
Gamma_Open)

Computing Return Loss

TekExpress Automotive Ethernet Automated Compliance Solution executes the
calculations described below for the return loss:

1. Multiply the acquired signals using Gaussian window (convolving in
frequency domain) and then compute the reflected and incident voltages.

Reflected voltage = (2*P1 – P2)

Incident voltage = P1

2. Return loss is computed as follows:

Return loss = FFT(Reflected voltage)/ FFT(Incident voltage)

Let the computed return loss be GammaValue.

3. Read the error coefficients a, b, and c from the dumped csv files. Compute
the corrected return loss using a, b, and c.

Corrected Return loss = (GammaValue – b)/(a – c * GammaValue)

This return loss is for 100 Ω load. Let this be return_loss_100.

4. For plotting purposes, Return_Loss_100 is converted to dB scale,
interpolated, and smoothed. Interpolated and smoothed Return_Loss_100 is
plotted for visual representation.

Return_loss_100 is compared with the specification given limit.

Transmitter clock
frequency

TekExpress Automotive Ethernet Compliance Solution automatically executes
the calculations described below for the Transmit Clock Frequency measurement.

1000Base-T1

Compute and verify the clock frequency between the High and Low limits as
mentioned in the table above.

 References

TekExpress Automotive Ethernet 167



100Base-T1

1. Configure DUT to Test mode 2. The test mode 2 signal is a clock signal
where the PHY shall transmit the data symbol sequence (+1, -1) repeatedly
on all channels.

2. Compute and verify the clock frequency between the High and Low limits as
mentioned in the table above.

Transmitter distortion TekExpress Automotive Ethernet Compliance Solution executes the calculations
described below for the transmitter distortion measurement:

1. Compute the unit interval of the acquired test mode 4 signal.

2. Determine the number of frames and the start and end of the frames (each
frame is 2047 bits long) in the acquired signal. Neglect the residual signal
present at both the start and the end of the acquired signal.

Ensure that all further processing happens from start of the kth frame to end
of nth frame.

3. Using the start and end frames information, do averaging across frames and
finally get an averaged frame containing 2047 symbols or (2047*k) samples
where k is number of samples per symbol.

4. Do single acquisition and collect 2047 samples corresponding to a phase
offset. These 2047 samples are picked from 2047 symbols and so each
sample represents a symbol.

The application removes the disturber signal as per the IEEE P802.3bwTM
D3.3 for 100 Base-T1 and IEEE P802.3bpTM for 1000Base-T1 MATLAB
code.

5. Repeat the previous two steps for phase offsets 0 to 1 UI in steps of 0.1 UI
(10 phase offsets). A total of 10 peak errors/peak distortions are obtained.

Transmitter output droop TekExpress Automotive Ethernet Compliance Solution executes the calculations
described as below for the transmitter output droop measurement.

1000Base-T1

1. Check if the input waveform pattern is a square wave test pattern or not.

2. Check the input square wave test pattern, whether positive to negative width
is , check whether positive and negative widths are greater than 12ns.

3. From zero crossing 4ns of each rising edge of each rising edge, compute the
maximum voltage (Vp_positive) and compute the voltage (Vdroop_positive) 16 ns
after that maximum voltage index (12 ns period).

Vd = (Vp_positive – Vdroop_positive)
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Positive Droop = (Vd/Vp_positive) * 100 

4. From zero crossing 4ns of each falling edge, compute the minimum voltage
(Vp_negative) and compute the voltage (Vdroop_nrgative) 16 ns after that
maximum voltage index (12 ns period).

Vd = (Vp_negative – Vdroop_negative)

Negative Droop = (Vd/Vp_negative) * 100 

100Base-T1

1. Check if the input waveform pattern is a square wave test pattern or not.

2. If it is square wave test pattern, then check whether positive and negative
widths are greater than 33 unit intervals (500 nS).

3. On each rising edge, compute the maximum voltage (Vp_positive) and compute
the voltage (Vdroop_positive) 500 ns after that maximum voltage index.

Vd = (Vp_positive – Vdroop_positive)

Positive Droop = (Vd/Vp_positive) * 100 

4. On each falling edge, compute the minimum voltage (Vp_negative) and
compute the voltage (Vdroop_negative) 500 ns after that minimum voltage
index.

Vd = (Vp_negative – Vdroop_negative)

Negative Droop = (Vd/Vp_negative) * 100 

Transmitter power
spectral density

TekExpress Automotive Ethernet Compliance Solution automatically executes
the calculations as described below for the power spectral density measurement.

1. The test mode 5 signal feed as input is filtered using a band limiting filter.

2. Spectral functions (SpectralMag) present in the oscilloscope MATH sub
system are used for computing the spectrum of the filtered test mode 5 signal.

3. The output of “SpectralMag” is averaged over “Averages” times. “Averages”
is an acquisition parameter present in the GUI (No entries in GUI for
1000Base-T1). The default value of this parameter is 64.

4. ”SpectralMag” is executed with the following configuration settings:

■ For 100Base-T1: Center frequency: 100.5 MHz, For 1000Base-T1:
Center frequency: 300 MHz

■ For 100Base-T1: Frequency span: 201 MHz, For 1000Base-T1:
Frequency span: 600 MHz

■ Window type: Gaussian

■ Vertical axis: scale —> Linear

■ Gating duration: 200 micro seconds
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■ Gating duration = Record length / sampling rate

■ 2.5 Mega samples / 12.5 GS/sec = 200 micro seconds

■ Gating position: 0 

■ R = 100 Ohm

5. Averaged SpectralMag is saved and used in postprocessing.

6. In postprocessing, the averaged spectral output is filtered using a moving
average filter (smoothing).

7. Computed power in dBm is compared with limits given in the specification,
which gives limits only at certain frequencies. Linear interpolation is used to
find values for intermediate frequencies.

Power(dBm) = Power (dBm/Hz) + 10 x log 10(BWHz) where, BWHz -
Bandwidth resolution

Transmitter timing jitter
master and slave

TekExpress Automotive Ethernet Compliance Solution automatically executes
the calculations as described below:

1. Edge locations in test mode 2 (100Base-T1) / test mode 1 (1000Base-T1) for
Master waveform, SLAVE TX_TCLK (100Base-T1) / SLAVE
TX_TCLK125 (1000Base-T1) for Slave waveform, (captured in differential
form) are determined with middle level percentage as 50%. Hysteresis and
EdgeType are entered by user in GUI.

2. The least square method is used for straight line fit, with Y as the edge
locations and X as the edge indices. Only edges that match the EdgeType
entered by the user in the GUI are considered for fitting. Slope and intercept
are determined as the output of the least square method. Using the intercept
and slope, reconstructed edge locations are determined (un-jittered
reference).

reconstructedTime(I) = intercept + I * slope, I = 0 to num_edges(num_edges
depend on EdgeType)

3. Compute TIE on EdgeType entered by user in GUI.

TIE(I) = reconstructedTime(I) – EdgePosition(I), I = 0 to
num_edges(num_edges depend on EdgeType).

Compute rms value of TIE, which is reported as the result.
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Transmitter timing jitter-
MDI jitter

TekExpress Automotive Ethernet Compliance Solution automatically executes
the calculations described below for the measurement Transmitter Timing Jitter-
MDI Jitter.

1.

2. Compute and verify the clock frequency between the High and Low limits as
mentioned in the above table.

How to load the setup file into AFG31000 for Return Loss measurement
(100 BASE-T1)

This section describes the steps to load the setup file into the AFG31000 for
return loss measurement (100BASE-T1).

1. Click Setup > DUT.

2. Select View as Advanced.

3. Click Test Selection tab and Select Return Loss measurement.

4. Click Configuration and select Calibration tab.

5. Click the link Click here and copy files to USB drive and recall on connected
signal source.

6. Plug in a USB drive into the USB port of the oscilloscope and copy the
respective AFG setup files.
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7. After copying the setup files, unplug the USB drive and plug it into the USB
port of the AFG.

8. On AFG:

a. Press the Default button. A confirmation pop-up message appears on the
screen.

b. Press OK to recall the default settings.

c. Press SAVE/RECALL button.

d. Go to the Save & Recall tab on the touchscreen and select Recall.

e. Select USB and browse to setup file folder.

f. Select the *.tfs file and click OK.

g. On the touchscreen, swipe the white arrow at the bottom of the screen up.

h. Go to the ArbBuilder tab and click Open.

i. Select USB and browse to the setup file folder.

j. Select "...Pos.tfw" file and click OK.

k. Click Send > To Ch1 and then click Exit.

l. Go to the ArbBuilder tab and click Open.

m. Select USB and browse to the setup file folder.

n. Select "...Neg.tfw" file and click OK.

o. Click Send > To Ch2 and then click Exit.

p. Select InterChannel tab and click Align Phase.

q. Turn ON channels 1 and 2.

Measurement results in CSV file

Droop measurement When you save a session, droop measurement results are saved in
DroopAllCycleRes_Run1.csv file. The file contains the following detailed results
for each cycle.

1. Cycle Number
2. Vpk (V) of the positive cycle
3. Vd (V) of the positive cycle
4. Positive Droop Result (%)
5. Positive Droop Result- Pass/Fail with respect to specification limits
6. Vpk (V) of the negative cycle
7. Vd (V) of the negative cycle
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8. Negative Droop result (%)
9. Negative Droop result - Pass/Fail result with respect to specification limits

 

 

The .CSV file is saved inside X:\Automotive Ethernet\DUT001\<SessionID>\
folder.

PSD measurement When you save a session, PSD measurement results are saved in
PowerSpectralDensity_PlotData.csv file. The file contains the measurement
results in two columns (Frequency (Hz) and PSD (dBm)).
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The .CSV file is saved inside X:\Automotive Ethernet\DUT001\<SessionID>\
folder.

Return Loss measurement When you save a session, return loss measurement results are saved for in
plotdata_rl_100.csv file.
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The .CSV file is saved in the below listed folders, based on the calibration
method used:

■ Pre-recorded calibration files: X:\Automotive Ethernet\PreRecCal\100Base-
T1\

■ Live Calibration: X:\Automotive Ethernet\LiveCal\100Base-T1\
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Technical support, 3
Test fixtures, 7
Test groups, 26
Test limits

changing, 38
Test reports, 75
Test results

viewing, 53
Test Results Summary, 53
Test setup files, 54
Test setups

creating based on existing, 87
deleting, 87
recalling, 86

saving, 86
Test status

acquire status, 51
analysis status, 51
auto scroll, 51

Test Status, 82
Tests

configuring, 38
selecting, 26

U
User Comments

including in reports, 75
User Defined Mode, 38, 49

V
Version, 9
Vertical Setup, 41
View a report, 75

W
Waveforms

acquiring live, 29
Wavelength, 25
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